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Section 1 Overview

High-performanceHMI system software is a software package designed for the control system
configuration and supervision of OMC. This system software supports control domain distribution,
operation domain distribution, parallel configuration, single domain import and export, single
control station import and export, single control station configuration backup, on-line debugging,
on-line downloading and multiple databases within the system structure.

1.1 Basic Process of Project Configuration

System configuration is the process of configuring each software and hardware parameter for
control system from engineer station. Many system functions and corresponding parameters need
to be assigned according to specific situation due to the generality and complexity of DCS. For
example, how many control domains and operation domains does the system contain; how many
control stations or operation nodes does each control domain and operation domain contain; what
kinds of signal does the system collect, what kind of control scheme to adopt, how to control, what
data need to be displayed during operation, how to operate, etc. In addition, in order to meet
various specific demands, DCS provides abundant I/O modules; various control modules and
multiple operation platforms. Hardware devices are usually chosen according to system request
during configuration; when communicating with other system, the protocols and ports adopted in
the system need to be provided.

DCS configuration is a step-by-step process with comprehensive application of multiple types of
software. When configuring the control system with High-performanceHMI system software, it can
be carried out step by step according to the technical demand.

1.2 System Configuration Work Flow Chart

The main system configuration work flow chart is shown as Figure 1-1.
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Figure 1-1 System configuration flow chart

The operations in the above flow chart are described as following.

1. Project design

Project design includes measuring points list design, regular (or complex) objects control
scheme design, system control scheme design, flow charts design, report forms design
and relevant documents compiling, etc. After project design is complete, Measuring
Points List, System Configuration Manual List, System Topology Figure, Control Cabinet
Layout, I/0 Layout, Control Scheme and other technical documents should be
generated.

Project design is the basis for system configuration, therefore, system configuration

must be carried out after the project design is complete.

2. System Builder

System builder is achieved by VFSysBuilder. Its main duty is to configure the system
structure and project management authority.

System global structure configuration is to determine system control domain, control
station, operation domain, operation domain server, operator (engineer station)
according to System Configuration Manual List and System Topology Figure.

After the project is built, inspection and modification of system structure, configuration of
the control station and control domain can only be implemented by engineers with
corresponding authority.

Once the system structure is fixed, try to avoid its modification.

3. 10 Builder
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Configuration of communication module and I/O module is carried out within the
hardware configuration software (VFIOBuilder) according to the requirement of 1/0

Module Layout and Measured Points List.

4. Tag Builder

Tag build is carried out in VFTAGBUuilder. I/O tag build is carried out according to the
requirement of measured point list; variables used in the system communication are
defined according to requirement of project design; variables employed to interact

between program pages are defined according to the requirement of custom program.

5. Custom program configuration

The requirement of Control Scheme is achieved by FBD or LD, or other programming

languages.

6. Compile and download

Download all the information required for control station operation to corresponding

controllers.

7. Operation domain configuration

This option is to set the general configuration of operation domain, including operator
authority configuration, panel authority configuration, domain variable configuration,
history trend configuration, custom alarm group, shelve alarm, manage state, procedure,
etc.

Operator authority configuration is mainly to assign the authority of the operator.
Different levels of users are defined in the software to ensure operation authority, namely,

users of a specific level can only perform their specific operation authority.

8. Operation team configuration

Operation team configuration is to set operation teams within each operation station, so
that different operation teams can observe, set and modify different standard displays,
graphics report forms, custom keys, etc. Operator grouping is benefit for assigning the
duty of operators, simplifying the operator's operation and emphasizing the important

points of supervision.
9. Resource file configuration
Resource file mainly includes graphics and schedule. Particularly, graphics configuration

takes more time, so it can be carried out independently in the early phase of project,

then being integrated.

10. Publish
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Publish the project configuration in the server to corresponding operation domain or

operator station (engineer station).
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Section 2 New Project

System configuration process and operation procedure are illustrated by the following example
according to the instructions of system configuration working flow chart. The project example is
just for instruction of configuration procedure and method, and doesn't guarantee the rationality of
the configuration content.

2.1 Configuration Prophase Preparations

All documents and materials required in the configuration, including system structure, module
layout, measuring points list, data grouping method, system control scheme, supervision display,
report forms, etc. should be collected before the configuration. The system requirement in this
example is as follows:

System is composed of 2 control domains, which are "Combustion" (domain address is 0) and
"Turbine" (domain address is 2). There are 2 control stations in “Combustion” control domain:
"Steam_Water"(address is 0.2) and "BOP"(address is 0.4). There are 2 control stations in
“Turbine” control domain, which are "Turbinel"(address is 2.2), "Turbine2"(address is 2.4). Tag
statistics is as follows:

Table 2-1 Tags statistics table

Station NaTag EEs Al AO DI DO Custom tag Total
Steam_Water 400 96 112 16 >113 >737
BOP 103 24 32 16 >23 >198
Turbinel 208 32 48 >29 317
Turbine2 384 80 48 32 >271 815
Total 995 232 240 64 >436 2067

2 operation domains are set: "MainSteamConV" and "PAttemperatorConV". It is required that
“MainSteamConV” operation domain supervise “Combustion” control domain and “Turbine” control
domain simultaneously while “PAttemperatorConV” only supervise “Turbine” control domain.
Operation domain settings are as follows:

MainSteamConV operation domain: operates and controls 2 control domains.

® Server: [0.159] Data Server 1
® Server: [0.160] Data Server 2

® Operation Node: [0.161] Engineer Station, [0.162] Operation Station, [0.163]
Operation Station, [0.254] Operation Station
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PAttemperatorConV operation domain: operates and controls the Turbine control
domain.

® Server: [2.159] Data Server 1

® Server: [2.160] Data Server 2

® Operation Node: [2.165] Operation Station, [2.166] Operation Station

0S162 is the configuration server.

@ Tip:

In principle, apart from dividing control domain according to process feature and system
scale, it is mainly carried out according to the requirement of supervised control domain in
the operation domain. Whether operation domain needs to be supervised can be determined
in the unit of control domain. If supervision is not needed, operation nodes within this
control domain would not be able to receive the data of this control domain. If an operation
domain needs to supervise control station A and B, but not C, then control station A and B
can be placed in the same control domain, while control station C cannot be placed in the
same control domain of A and B. Operation domain is mainly divided according to the
system load and supervision requirement of operation node. Operation nodes belong to the
same control domain can supervise several control domains at the same time, and different
operation domains can supervise the same control domain at the same time, namely, a
control domain can be supervised by several operation domains at the same time.




Project Guide User Manual

2.2 Topological graph of the system
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Figure 2-1 Topological graph of the system

2.3 System Builder

j Tip:
For more operation instruction details of System builder, refer to the System Builder User
Manual.

After system structure is determined, system structure can be configured in the configuration
server.

System builder is mainly to configure the system structure and management authority of the
project. System structure mainly includes control domain, control station, operation domain and
operation node.

2.3.1 New Project

bl
JsBUilder

Click icon on the desktop of the configuration server to start up the VFSysBuilder,
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click new project then input project name and creator, shown as Figure 2-2:

I ey >
Praoject: | |
Creator: | Sl
Path: | L\ SUPCON_PROJECT),
| o4 | Cancel

Figure 2-2 new project

Input project name in the New Project dialog box: INDBARATHPOWER; Creator: supcon, click
"OK", and the new password dialog box giving choice whether to create password for "supcon” will
pop up. Choose "NO", and the engineer password would be empty; choose "YES", and the user
can set engineer password, the pop-up window for creating password is as Figure 2-3:

Create Passward 4

Mame: | adrnin

Mew Passward: | |

Confirm Password: |

Description: |

v Project Management Suthaority

K, | Cancel

Figure 2-3 set the engineer password

Input engineer password and confirm password, and then click the button "OK" to start
VFSysBuilder.

2.3.2 Add Reference Project

The monitoring of CCR for several FAR can be achieved by reference project via mutual reference
of real-time data among projects. A project can reference 1~32 projects.

Configuration of reference project can be achieved by following steps:

1. Select “Referenced Project” in work space.

2. Right-click and select “Add Reference Project” to add a sub-node to “Referenced Project”
automatically.
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Input the address of reference project in “Configuration Properties Bar” (i.e. 172.30.1.156
in the figure below). After setting successfully and the address is valid, the information of
the referenced project is shown in properties bar, such as the contained operation
domain and its properties.

EJproperties . |

Mame

Address
= Operation Domain
E| Operation Domaind

Server Address

INDBARATHPOWER
172.30.1.156

172.30.1.156

Figure 2-4 Configure reference project

After adding successfully, the operation domain can be referenced in the operation domain

configuration.

Tip:

@ If the operation domain in a project is referenced, the project cannot be deleted until the
referenced operation domain is deleted.

2.3.3 Add Control Domains and Control Stations

After project has been created, firstly, add control domain according to system structure, right click
"Control Domain ", and select “Add Control Domain”, shown as Figure 2-5:

Project

E--@ INDBARATHPOWER
Configuration Server

. Global Default Settings

- Unit Configuration

E@ Security

- g\ Electronic signature

Eﬁ Alarm Pricrity

[-]@ Reference Project
[ CCR_PROJECT

Operation Domain Configur:
H--m Engineer

& admin

Figure 2-5 add control domain

----- % Control Domain Configuratig
P

= Control Domain

Click the new control domain, its name and address can be modified in the right pane.
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Right click the control station, and choose "Add Control Station” in right-click menu to add a control
station within the control domain. Modify the control station name, address, description and type.

Follow the steps above and complete setting the control domain and control station information.

2.3.4 Add Operation Domain and Operation Node

Firstly, create an operation domain. Right click "Operation Domain", and choose "Add Operation
Domain" in the right-click menu, shown as Figure 2-6:

Project x Operation Domain

E-@ INDBARATHPOWER

----- . Configuration Server

|_‘_| r ¢ Global Default Settings
Unit Configuration
& Security
- g\ Electronic signature
= j Alarm Priority

------ “...[ T JX-300XP/ECS-100 Alarm L
E]--@ Reference Project
[—]% Contrel Domain Configuration
é.ﬁ [0]Combustion

------ u [0.2]5tearmn_Water

‘. Operation Domain Config
B m Engineer % A:ﬁ Operation Domain

------ ﬁ admin | T

SCnet B Address

Figure 2-6 add operation domain

Modify the operation domain properties, etc., shown as Figure 2-7:

Project NN < B Properties

EI--@ INDBARATHPOWER Name. . Operation Domain2
[B=| Configuration Server D‘_:"S':”m'c'n
B Global Default Settings Alias : DA21156
H- @ Reference Project = Control Don_"a'“
- % Control Domain Configuration [0]Combustion
E| & [0]Combustion [1]C.ontrol Domain‘
‘ [0.2]5team_Water g Engll-leer
----- ﬁ [1]Control Domainl admin
B ‘. Operatmn Domain Configuration L
: 'm] Operation Domaind B Status
- [1.156]5erver_1_156 Last Configuration Updated Time 2021-07-14 15:09:55
E| Operation Domain Properies Mo
:... [0.254]Server_0_254 1
E| ) Operation Domain2 Tick off to assign configuration authority of the operation domain to engineers.

..... . [2.129]Server_2_129
[]--m Engineer

Figure 2-7 modify operation domain attributes

Set the name, network address, etc. for domain server. Right click “MainSteamConV”, and then
choose "Add Operation Node" in right-click menu to add an operation node in this operation
domain. Modify the name and network address of the operation node, shown as Figure 2-8:

10
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Project x |B Properties
i} Global Default Settings B Hiame 0S_0_162
@ Reference Project Description
EI% Control Domain Configuratior Addres_sl 0-152_ .
Eﬁ [0]Combustion SCnetAAddress 17’3_3._._.:._1-?5
‘ [0.2]5tearn_Water . ?L'..L'1.I_I.1'JL-.
& [1)Control DemainT Operation Node Type Engineer Station
=B Operation Domain Configurati Operation Node Systern Alarm Check O
EI Operation Domainl SCnet Connection Redundancy Netwark
[ [1.156]Server_1_156 B SONet N
[_]" Operation Domain1 S0netAAddress 72.30.0.162
.. [F5] [0.254]5erver_0_254
|'_—'|-- Operation Domain
. [0.159]Data Sever Description
@ The length of description cannot exceed 128 bytes.
Eﬂ--m Engineer .

Figure 2-8 modify the properties of the operation domain node

Follow the above steps to complete all configurations of operation domain.

2.3.5 Add Reference Domain

After adding reference project, user can add “Reference Domain” in operation domain. An
operation domain can reference 1~128 operation domains.

User can perform following operations via reference domain:

® View and edit the graphics of the referenced domain.
® Perform HMI configuration for tag in reference domain.

® Search the history trend, history alarm and operation record of reference domain.
If the operation domain is not locked, add reference domain by following steps:

1) Right-click the specified operation domain in work space, and select “Add Reference
Domain”.

2) Pop up the “Reference Operation Domain” dialog, the domain inside is operation
domain of reference project.

11
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= Rgference Project
E1- 0821
v Operation Domain

Ik Cancel

3) Select operation domain to be referenced and click “Ok”.

After adding reference domain successfully, a node with icon ' will be added to operation
domain. The name format of reference domain is “Reference Project Name. Reference Domain

| 0 . . .
Alias”, such as ' 0821'6”3‘2?50, “0821" is the referenced project name, and “OA2760” is the
referenced domain alias.

Tips:
® The locked reference domain can only be deleted after being unlocked.

® Reference domain must be default project in configuration server of the specified
| § address.

® After modifying the domain alias in the referenced domain and publishing, the update of
referenced domain can be checked only after open the VFSysBuilder of referenced
project, and the modification can be valid only after saving them.

2.3.6 Configure Supervised Control Domain

If an operation domain hasn't been configured to supervise a certain control domain, the data of
this control domain is invisible to the operation domain. According to the requirement of system
configuration, in principle it's commended that one operation domain corresponds to one control
domain, and create another operation domain that can supervise all control domain which is
convenient for engineer to maintain DCS system. For example, in this project, “MainSteamConV”
can supervise Combustion and Turbine simultaneously; "PAtTemperatorConV" can supervise
Turbine, making it convenient for DCS maintenance.

Select the operation domain needs to be configured, and choose corresponding supervised
control domain, shown as Figure 2-9:

12
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=] LR LR PR

&-f2] Reference Praject

% Control Domain Configuration [0}Combustion . O
E| Operation Doemain Configuration [‘1]C.Gntrol Sisnas |
-- Operation Domaind = E“g"_]eer
B F] Op ration Domein' admin
: .-- Operatmn Daornaind E O
- m Engineer g LiEis
Last Configuration Updated Time 2021-07-14 15:09:54

Figure 2-9 configure the supervised control domain of operation domain

2.3.7 Management of Engineer's Authority

After the basic System builder is completed, engineer's authority of the project can be assigned.
Engineer's main authority includes project management authority, control station configuration
authority, operation domain configuration authority.

Right click "Engineer"” to add an engineer or an engineer group, shown as Figure 2-10:

Project I <

E-@ INDEARATHPOWER

----- . Configuration Server

. r ¢ Global Default Settings

- @ Reference Project

. % Control Domain Configuration

E| l. Clperatlu:un Domain Configuration
-- m| Operation Domainl
-- & Operation Domain
; Operation Domaind

-mw

Add En:h{ieer Group
ﬁﬂ, Add Engineer

Figure 2-10 add an engineer or engineer group

Project management authority is mainly set to open VFSysBuilder. This authority allows modifying
system structure and changing any other engineer's authority as well, so the engineer account
with project management authority should be strictly controlled.

After engineer groups and engineer accounts have been built successfully, configuration
authorities of engineer groups and engineers can be configured, mainly including configuration
authority of control domain and operation domain. Engineer's authority setting is shown as Figure
2-11:

13
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Project N < | Properties
=5 INDBARATHPOWER LU Engineer Groupd
Configuration Server Descrlptlon -
5.7+ Global Default Settings Praoject Management Autharity O
(-] Reference Project B LT L=l
[]...ﬁ Control Domain Configuration [U.E]Stelam_‘.".fate.r
|:_].. Operation Domain Configuration = Operalo" Domaln
185 Operstion Domaind
-- Operation Domain Operat?nn Dnmafm O
__ Operation Domain2 Operation Domain2 O
H--m Engineer
----- & Engineer Groupl
- ﬁ admin
e 1

Figure 2-11 set the configuration authority

2.3.8 Global Default Settings

Select "Common Default Settings" in configuration tree, and some global parameters of the project
can be configured in configuration property bar, such as the color of ON/OFF indicators, decimal
digits of tag and the color of panel alarm indicators, time synchronization servers configuration,
enable/disable latching alarm and alarm sort as shown in Figure 2-12.

14

EGlobal Defaut Settings |
0N Calar [ |
OFF Calar [ |
Decimal Digits of Tag Template 2
Monitaring Theme Default
CRcode Disahle
ResemedArea In Manitoring Disahle
Trend Draw Mode General Mode
Show trend line tag info O
Reference Domain Tag Info Mode Cnline

= Panel Alarm Color
Marmal Calar [ |

= Time Synchronization Senver
Time Synchronization Server Count 0

B Alarm Setting
Latching Alarm Colar [ |
Latching Alarm Sound Dizahble
Enahble Latching System Alarm Disahle
Re-alarming Time {min} 10
Alarm Eclipsing Enahle
Alarm Shelving Disahle
State Management Dizahble
Record Suppressed Alarm in History Alarm Enahle
Function Of Shielding Alarm Group And Alarm Region In Operation Domain  Disable
Alarm Status Display Rules Default
Alarm Sort Rule By Alarm Priority (Default)

B SONet
S0net Configuration Infarmatiaon Betwork Singled 72300
SonetAsddress 172.307*"

B IDM Server
ServerAddress
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Figure 2-12 Global Default Settings

Configure Monitoring Theme

In VFSysBuilder software, the real-time monitoring theme can be configured as:

® Select "Classical" in the dropdown list of "Monitoring Theme" to set gray as the
background color of the real-time monitor.

® Select "Default" in the dropdown list of "Monitoring Theme" to set blue as the background
color of the real-time monitor.

Time Synchronization Server Settings

Time synchronization server can synchronize each node in the LAN. One project must be
configured with one time synchronization server. Users can configure several time synchronization
servers in one project, and set one as the chief, the others as the standby at one time. Standby
time synchronization servers synchronize with the chief time synchronization through information
network, and client synchronizes with the chief time synchronization through control network. Time
synchronization server host ID should be 254 (the fourth part of IP address). Client determines
current time synchronization server node according to the principle of minimal domain address
(the third part of IP address).

When multiple time synchronization server configured, the domain address and node address of
the chief server should all be the minimum of the addressed of the servers.

Time synchronization server settings are shown as Figure 2-13:

Time Synchronization Server

Time Synchronization Server Count 3
Server 0
Type Software Time Synchronization Server(ECS-700)
Third Byte Address 0
IP Address of Time Synchronization Server 0.254
Server 1
Type Hardware GPS(ECS-700)
Third Byte Address 1
IP Address of Time Synchronization Server 1.254
Server 2
Type Time Synchronization Server(JX-300XP/ECS-100 direct domain)
The last two addresses 2129
IP Address of Time Synchronization Server 128.128.2.129

Figure 2-13 Time Synchronization Server Configuration

Units Configuration

Click the "Engineer Unit" under the "Common Default Settings”, the configured units will be
displayed in the right property setting area, shown as Figure 2-14:
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D Unt | D | Unt | D | Uit [ ID [ Unit |
0 % 1 milli 2 *C 3 F

4 5 5 M ] mmin 7 hour
] bar 9 mmH20 10 mmHg 1 Pa
12 kPa 13 MPa 14 kgf/cm2 15 tfs
16 t/min 17 t/h 18 L/s 19 L/min
20 L'h 21 kg/s 22 kg/min 23 kg/h
24 m3/s 25 m3/min 26 m3/h 27 Nm3/h
28 kW-h 29 MW 30 W 31 kW
32 WH 33 MHz 34 kHz 35 Hz
36 MNTu 37 ug/L 38 m3 39 ug/Kg
40 L 41 mlL 42 t 43 g
44 my 45 ma 46 rpm 47 atm
43 kg 49 km 50 m 51 cm
52 Frm 53 um 34 mbar 55 Mm
56 usfem 57 A 58 ket 59 VA
&0 v &1 kV 62 r/min 63 PH
) ppm 65 Mm3 66 KpaG &7 mg
68 Var 69 VarH 7o

Figure 2-14 units configuration

Click the grid near the number with * in the units configuration interface, and input required units,
then press Enter or switch the focus to other place, a new unit can be added (the operation should
be saved in the VFSysBuilder to finish adding).

Need Confirm Settings

Click the node "Security" under “Common Default Settings” the right area of interface will display
as Figure 2-15:
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& VFSysBuilder - INDBARATHPOWER = O x
File Edit Miew Advanced Help
DE R & |3
Project ® | MNeed Confirm \ ~
E‘@ INDEARJO.‘THPC.]WER ” Tag Level ‘ Meed Confirm | ~
Configuration Server 0
-2 Global Default Settings O
Unit Configuration ! O
o & B 2 O
g\ Electronic signature k] D
- Alarm Priority 4 0
“...[Tg| JX-300XP/ECS-100 Alan
[]—-@ Reference Project : D
[]---% Control Domain Configuratior & O
|:-j|-- Operation Domain Configurati 7 O
=@ . .
B e o || O
< > 9 O v
v
Project < >
Ready NUP

Figure 2-15 Need Confirm configuration interface

Whether modified value of tag during supervision via instrument panel need to confirm for second
time can be implemented by selecting or not selecting the item in front of the tag level.

The tag level can be configured in the tag table, shown as Figure 2-16:

B Supervision Settings
Tag Group Tag Group O
Tag Level Level O -

Decimal Digits
Panel g
eve
Related Tag Leval 2 5
Level 4
Tag Level Level 5
Tag Level Level &
Level 7
Level 8
Level 9

Figure 2-16 tag level configuration

Alarm Settings

User can configure the alarms in system together via alarm settings, which including latching
alarm sound, realarm time, alarm conflation, shelve alarm, manage state, system alarm color and
alarm sort rule.

Global alarm settings can be completed in combo box shown below.
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E Alarm Setting

Latching Alarm Colar [ |
Latching Alarm Sound Disahle
Enable Latching System alarm Dizable
Re-alarming Time {mim 10
Alarm Eclipsing Enable
Alarm Shelving Disahle
State Management Dizable
Fecord Suppressed Alarm in History Alarm Enable
Function Of Shielding Alarm Group And Alarm Regior Disahle
Alarm Status Display Rules Default
Alarm Sort Rule By Alarm Priority (Default)

Figure 2-17 Alarm Setting

Configure SOnet

Configure the SOnet connection in “SOnet” of “Global Default Settings” interface.

E SONet
S0net Configuration Information Network Single(172.30)
S0netAAddress 172,30+

S0net Configuration

When operation domain is locked, the network type cannot be changed

Information Metwork Single(172.30): information network uses dedicated network segment of 172.30

Information Metwork Redundant{172.30/172.31). information network uses dedicated redundant network segments of 172.30 and 172.31
ECS-700 Control Metwork Single{only using Met B): information network and control net use 17221 network segment together

ECS-700 Control Metwork Redundant(Met B taking priority): information network and control net use 172.21, 17220 network segment together
JX-300XP/ECS-100 Single Met(128.128): information network use 128.128 network segement, which is control network of JX-300XP/ECS-100

Figure 2-18 Configure SOnet connection

ﬂ Attention:
®

Publish all to monitoring after modifying dual-net settings.

® |f SOnet and SCnet share the same network (including single network and redundant
network), system will start flow control function automatically, which will limit the
SOnet data flow to ensure the normal communication of SCnet.

2.3.9 Security

By security configuration, reconfirmation of tag's written and electronic signature can be set. When
running High-performanceHMI software with software dog had electronic signature, the "
Electronic Signature” can be shown in the "Global Default Settings > Security". By electronic
signature configuration, the operation including written to tag and acknowledged alarm can be
limited by electronic signature.
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Tips:

Publish all to monitoring after modifying dual-net settings.

Configure Reconfirmation for Tag
Set the tag level to pop up reconfirmation dialog box when the tag value is modified in supervision.
Click "Security" in “Common Default Settings”, and interface on the right will be shown as follows.

Meed Confirm |

Tag Level Meed Confirm
0

OO0O0oOoOoo0ooOon

0w

Figure 2-19Interface "Need Confirm"

Whether to pop up reconfirmation dialog box in supervision when the tag value is modified can be
set by selecting in the interface of "Need Confirm”.

Electronic Signature

@ Attention:
When the software dog has the privilege of electronic signature, the "Electronic Signature" node
can be shown and configured as the sub-node of "Security". Otherwise, the node will not be
shown.

By the configuration of electronic signature, operations privilege to tag and alarms will be defined.
The privileges include electronic signature by tag level, alarm confirmation and batch processing.

Click "Global Default Settings > Security > Electronic Signature”, the right area will display the
electronic signature configuration as shown as figure below. In the electronic signature
configuration, there are three tabs including "Tag Operation", "Other Operation" and "Predefined
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Comments".

Tag Level Type re of alarm confin
0 Unsigned O
1 Unsigned O
2 Unsigned (|
3 Unsigned O
4 Unsigned O
3 Unsigned O
b Unsigned (|
7 Unsigned O
8 Unsigned O
9 Unsigned O

Figure 2-20 Electronic Signature Configure Example

2.3.10 Alarm Priorities
User can set alarm color, alarm shelve, alarm sleep and realarm for alarms in different levels.

The alarm priority amount cannot be modified after setting when creating project, while other
properties of alarm priority can be configured. Here takes system default 6 alarm priorities as an
example to introduce the configuration of alarm priority.

Select Global Default Settings/ Alarm priority in project bar, following interface will be shown in
the right configuration properties pane.

Alarm Prio... | Alarm lcon ‘ Alarm Description | Alarm Color ‘ Alarm lcen Font C.. | Data Logging Only Alarm Shelving Latch {v.) | Re-alarm (v.)
0 Monshape Log _ Yes Disable Disable Disable
1 Rectangle Low l:l _ MNe Disable Disable Disable
2 Rectangle Medium l:l _ Mo Disable Disable Disable
3 Rectangle High _ _ Mo Disable Disable Disable
4 Rectangle Urgency _ l:l No Disable Disable Disable
5 Rectangle Safe Related _ l:l Mo Disable Disable Disable

Figure 2-21 Set alarm priorities

Configure alarm functions used in the current project in the above figure.

2.3.11 Set Default Project

There may be more than one project in the configuration server and VFSysBuilder can edit each
project, but VFExplorer and supervision software read only the default project configuration.
Therefore, if current project configuration needs to run in VFExplorer or supervision software, it
must be set as default project.

When a project is open in VFSysBuilder, click the button =] to set the current project as default
project, and if there is a default project existed in current server, the password with the project
management authority of current default project is required to modify current project to default
project.
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2.4 Control Configuration

Control configuration mainly includes hardware configuration, tag configuration, custom function
block configuration and custom program configuration.

When System builder is completed, control configuration can be carried out

in the configuration management software (VFExplorer). Double click the icon [2 ——tO Start up
VFExplorer. Engineer account and password of current default project are required to login

VFEXxplorer.

Legin - INDBARATHPOWER et

User: | sUpCon

Password: |

Configuration Server: |L|:--:a J

Configuration Database Path;
| D:\SUPCON_PROJECTY,

QK | Cancel

Figure 2-22 login VFExplorer

The configuration database directory should be the project configuration directory in the
configuration server. If the directory is not correct, the project in the configuration server can't open
in VFEXxplorer.

L,jj__l Tip:

The path of configuration database can be set in Start > OMC > Intelligent Application
Management. In Intelligent Application Management, click System Global Options.

2.4.1 Open Configuration

Except global function block, other control configuration is normally stored in the configuration
server, and if needs to be edited, it should be open from the configuration server. Make sure that
current login engineer has the configuration authority of this control station; it can’'t open without
the authority. The way to open the configuration is shown as Figure 2-23:
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E| X Control Configuration
=] ﬁ [0]Combustion

E ﬁ [1]Control Do Open From Configuration Server I},
B- E‘g HMI Save to Configuration Server

= Operation Do
Operation Do
Operation Do

Save to Configuration Server (Locked)

View

Simulation

Figure 2-23 open configuration from the configuration server

I:q_s'_' Tip:

For more operation details, refer to Config Explorer User Manual.

2.4.2 Hardware Configuration

The task of hardware configuration is to configure the control station hardware, mainly includes
parameter settings, communication module configuration, 1/O module configuration of the control
station. It's recommended to configure the hardware before tag build, to make it more convenient
for tag build.

4. Open the control station configuration from configuration server.

E--@ INDBARATHPOWER A | Name | Description Last Modified Time
B8 Configuration Server 5 Custorn Program
g% Common Settings £ Custom Function Block
- System Function Block Library Il Hardware Configuration 2021-07-14 15:52:18
Global Function Block Library Tag Table 2021-07-14 15:52:18
Phase Class Library g2 Unit Control
[ Program Template Library IEFF List
= ﬁ Control Configuration
E| ﬁ [O]Combustlnn
o R

Figure 2-24 open control station configuration from configuration server

5. Double click "Hardware Configuration" in the VFExplorer to start up the hardware
configuration software (VFIOBuilder).
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[l VFIOBuilder - INDBARATHPOWER\Combustion’\Steam_Water[0.2] — O X

Eile Edit Operation Debug VYiew Help

E&X& B Sm @

Workspacel - < |2 Configuration A
7 E Address ooz
""" W |[002FCUT11-S * Model FCU711-S
Mame Controller
Description
Remark
Redundancy Yes

System Power Consumption (W) 12.00  (0.5000A * 24V)

Auxiliary Power Consumption(W)  0.00 (0.00004 * 24V)

Domain Address 0

Basic Scan Cycle(ms) 100 v

Hardware Configuratio...
Ready Channel: 0/0

Figure 2-25 hardware configuration interface

6. Right click a controller to add an 1/O link module or communication module node. A virtual
I/0 link module should be added to local node, and the address of local node should be
0.

Add Module =
Maodel COM701-5 System | Address |2 _I

COM701-5 Virtual LiO Link Module

COM711-5 IO Link Module

COM712-5 System Interconnection Maodule

COM715-5 distributed I/O interface module

COM721-5 PROFIBUS Communication Module

COM722-5 PROFIBUS Communication Module

COM723-5 PROFINET Communication Module

COM725-5 EtherMet/IP Communication Module
COM741-5 Serial Communication Module

COM742-5 Ethernet Communication Module

COM7S51-5 IO Link Module(Harizantal)

COM7E1-5 Serial Communication Module(Horizontal)
COM753-5 PROFIBUS Communication Module(Horizontal)
COM7E4-5 PROFIBUS Communication Module(Horizontal)

W Add Close

Figure 2-26 add a node

7. Right click the node to add rack, which is similar to adding a node.

j Tip:
When configuration export with project export tool is needed, the format of “Remark” has to
be “SC cabinet number - rack number: practical remark information.”
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8. Right click the rack to add an I/O module, which is similar to adding a node.

9. After finished adding I/O modules, modify the parameters of /O modules one by one,
shown as Figure 2-27:

[Ell VFIOBuilder - INDBARATHP OWER\Combustion'Steam_Water[0.2] S O X
Eile Edit Operation Debug Yiew Help
(= SR %X BB
Workspace » x |BE Configuration "
p— T Address 0oo
=0 [002FCuT-S Model AT711-5
E"@ [000]COMT0N-5 Marne Analog Input Module(8 Channels)
-1 [D00]CMT21 Description
& o [000]AIT1 Rermark
' [D01]AI72 Redundancy Mo
' [002]AIT1 System Power Consumption(W) 1.20  (0.05004 * 24V
. A _ Auxiliary Power Consumption(W)  3.80 (0.1620A * 24V)
-8 [003]AI71 sampling Cycle 200ms
- {8 [D04]AITT Channel[000][000][000][000] Current{4mA~20mA) v
-G [005]AIT1
AN e s - R4
< >
Hardware Configuratio...
Ready Channel: 8/8

Figure 2-27 modify the parameter of /O module

If all I/O modules hardware under the controller have been connected, configuration can also be

carried out by scan and upload. Click the button = , and pop up dialog box "Configuration Scan
and Upload", as Figure 2-28:

Configuration 5can and Upload >
Scan Options

" Scan All the Modules

{* Scan Mew Added Modules ﬁ

Status

Figure 2-28 hardware scan and upload

I:q_s'_' Tip:

For more details about hardware configuration, refer to Hardware Module Builder User
Manual.
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2.4.3 Tag Build

Double click "Tag Table" in the configuration management software (VFEXxplorer) to start up tag
build software (VFTAGBUuilder), which is similar to opening hardware configuration software
(VFIOBuilder).

Tag build is implemented according to single control station, mainly including I/O tag, customized
variable, page exchange variables configuration. In addition, function block tags are also displayed
in the tag table, but can't be added, modified or deleted in tag table. Of all tags, 1/O tags,
customized variables and function block tags belong to supervision exchanging variables, so they
cannot have the same name in the entire project.

1. Configure I/O Tag

Import and export method is recommended when configure batch of I/O tags, especially for the
first time to configure 1/O tag. The format of imported file must comply with requirements and the
hardware address must be in accordance with hardware configuration, so it's recommended to
scan hardware channel first (this hardware channel is corresponding to each hardware
configuration module instead of the channel of module actually connected to the controller), then
export the tag table and modify the tag name, tag parameters, etc. in the exported tag file. After
moadification is finished, import the tag file again.

10. Scan hardware tags. Select menu command Operation/ Scan Tags from
channels/Scan All

11. Export tag table. Click export, then choose the directory and input file name to save the
file, shown as Figure 2-29:

&
File Edit Operation View Help
}( Analog Input - | i é & %‘iz @
D | Type | Name | Description | Minimum | Maximum | Unit | Signal Type |Address A
0 Anal.. AIODD20000 Standby 0.0000 100.0000 % Current{4mA~20... 000-000-000-001
Export X [
Export File | D:\Table List.xls =
Export Made er
Key Word for Sort: |1/O Channel Addre: »| SortMode: |Ascending ~|| F™
Export Mode for Non-I0 Tag: e K
Key Word for Sort: |10 | SortMede: |Ascending - e K
F v
< Ok | Cancel | >
): In module AI712-5, channel (000-000-007-003) adds Al tag AID0020059. -

In medule Al712-5, channel (000-000-007-005) adds Al tag AIDD020061.
In madule AI712-5, channel (000-000-007-006) adds Al tag AIDD020062.
In madule AI712-5, channel (000-000-007-007) adds Al tag AIDD020063.

In module AI712-5, channel (000-000-007-004) adds Al tag AIDD020060.
I Finish scanning, 64 |0 tags added.

=1

Qo

\ Output / | |

Ready Net down |1/64 NUM

Figure 2-29 export tag table
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12. Open the EXCEL file exported in the previous step, and modify tag name, description,
measure range etc.

13. Import tag table.

ﬂ Attention:
Before import tag file, delete all the tags in the tag table first.

Select the modified file to import. Small changes of tag can be achieved in the property setting
area, Modification of tag name, tag description, etc. can also be achieved by double click
corresponding item in the tag list.

E VFTAGBuilder - INDBARATHP OWERNCambustion' Stearm_Water[0.2] = O >
Eile Edit Operation Miew Help
.| Analog Input - | i 2| e | 3E
1D | Type | Mame | Description ~ |[E Basic Properties -
15 Anal... AID0D020015 Standt Number 16
, - Mame AIOQND20016
16 | Anal... | AI00020016
- : m— 5 b Type Analog Input
' s AL = Attt Description Standby =
20 Ang ATD00Z0020 Standk e
£ >
:: Table "Al" the tag in the row 61 (Mo:39,Name: AIOD02005%) named AIDDD20059 (Mo: 39) has updated ~

Table "Al": the tag in the row 82 (No:60,Mame AIDDD20060) named AIDDD20060 (Mo: 80) has updated
Table "Al": the tag in the row 83 (No:61,Name AIDDO20061) named AIDDD20061 (Mo: 1) has updated
Table "Al": the tag in the row 84 (No:62 Name AIDDD20062) named AIDDD20062 (Mo: 82) has updated
Table "Al": the tag in the row 85 (No:63,Name AIDDD20063) named AIDCD20063 (Mo: 63) has updated

ag importing finished!
v

g \ Output ‘,/ | |

Ready Mot down

Figure 2-30 modify tag parameters

2. Customized Variables

Customized variable is mainly applied intermediate variables can be read and write during
supervision, and it can be used in custom program. Normally custom variables should be designed
together with 1/0 tags, and listed in the I/O list manual. I/O tag method can be adopted to add
batch of customized variables, it is edited in the exported EXCEL table before being imported.

3. Exchange Variables between Pages

Exchange variables between pages can only be used to data exchange between program pages,
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and invisible to supervision of control station.

® Choose tag types

Choose any exchange variable between pages in the tag list (Other variable type can

also be added in the same way).

£ VFTAGBuilder - INDBARATHP OWER\CombustionSteam_Water[0.2] = O >

| File Edit Operation View Help

JX|PageExchangeﬁnalog j|ﬁ|%|ﬁ’|a||ﬂ|%=|@
Analog Input

B - Analog Cutput pn

Digital Input

Digital Output

Custom Analog

Custom Digital

Custom Integer

Page Exchange Digital

Page Exchange Integer

Function Block Tag

< Show All >

Table "Al": the tag in the row 61 (Mo:59, Name:AIDD020059) named AIQ0020059 (Mo: 59) has updated ~
Table "Al": the tag in the row 62 (No:60, Mame AIDDD20060) named AIQ0020060 (Mo: &0) has updated

Table "Al": the tag in the row 63 (Mo:61, Name:AIDD0O20061) named AID0020061 (Mao: 61) has updated

Table "Al": the tag in the row 64 (No:62, Mame AIDDD20062) named AIQO020062 (Mo 62) has updated

Table "Al": the tag in the row 63 (Mo:63,Name:AIDD020063) named AIQ0020063 (Mo: 63) has updated

Tag importing finished!

a | 4] 4] [ r]\ Output / 4] o

Figure 2-31 choose tag type
® Add tags

oL
Click button to add a tag, shown as Figure 2-32:
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E VFTAGBuilder - INDBARATHP OWER\ Combustion’\ Steam_Water[0.2] e O *

File Edit Operation Yiew Help

?( Page Exchange Analog - | i @% |ﬂ| %"z @

D | Type | MName | Description E Basic Properties

70000 Page Exchan... PA0D0020000 standby Number 0
Mame PAQOO20000
Type Page Exchange
Description  Standby

Bl Initial Value

Initial Value  0.0000

Output EErI - *

\ Qutput J./

Ready Mot d

Figure 2-32 Add a tag
® Modify tags

Modify the tag parameters in the property setting area after finishing adding tags.

4. Function block tag

Some complex function blocks (such as PID loop) can pop up panels in supervision and quote the
parameters in PID loop (PV, MV, etc.) as well, therefore, these function blocks also have tags. The
function block tags can be added in the function block diagram programming software
(VFFBDBUuilder), and can only be summarized in the tag table.

For example, adding a function block PID in the function block diagram programming software
(VFFBDBuilder), shown as Figure 2-33:
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| File Edit Program View Help

H @@ &BmX i|GFE = Ak gL S

12k VFFBDBuilder - INDBARATHPOWER\Combustion\Steam_Water[0.2] - [TEST]

||:|+ +0| oo +
o+ 0| ++ O

|
O
X

#  Function Block Libranm, - <

ILnDkup Function Block Library j
| PID
MName Description |
& rD General PID Function Blo...
& PIDEP PIDEP Function Block
£ PIDEX Extended PID Control Fu...
& piD_TP PID Function Block for P...
& PID_TUN PID Self-tune Function Bl...
* it ePID EPID Control Function BI...
0.00] _IBKIN MY _| ft LEPID LEPID Functicn Block
ON] _IBKINERR BKOUT _|
0.000 _IPV BKOUTERR _|
p0001 1#
v
£ >
4
l [4[ 4[» [¥I], Compile /Find, All Records 4] 3

Ready

CAP [NUM y

Figure 2-33 add a function block PID

Double click function block to add function block tag name, shown as Figure 2-34:

General PID Function Block

Property IBasic | Extended

MName PID
Input Status s Active " Inactive
Output Status i+ Active  Inactive
Description
Tag Group I[UU] Tag Group 0 LI
Tag Level IU LI
Decma Digts -
Panel I‘ LI
oK I Cancel Help
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Figure 2-34 set tags of PID

The function block tag information appears in the tag table after click "OK", shown as Figure 2-35:

E VFTAGBuilder - INDBARATHPOWERN Combustion'Steam_Water[0.2] = Od 4
| File Edit Operation View Help
J‘K|FunctionBlockTag v|ﬂ|%ﬁ|£|lﬁl%|@
o/ | Type | MName | Description | Program belo... | B Basic Properties A
oo0o1ipp Jep | [tesT SRR :

Mame PID

Type Function Block
=
1
g | 1] <[> [H]\, Output / <] Ll
Ready | INotd

Figure 2-35 function block tags collected in the tag table

5. Finish and exit

The program will check the entire configuration automatically before exit. If there are any
configuration errors (for example, 1/0 tag address conflict, I/O tag mismatches the hardware

channel), check result will be failed and there will be error prompt in the check result to confirm
whether to ignore the error and exit. If there are repeated names between stations, exit from

VFTAGBUilder is forbidden.
Exit

Exiting,please wait...

Chedking the tag amount Pass!
Chedking the global tag name repeated Pass!
Checdking IO tag address conflict Pass!
Chedking tag properties Fass!

Figure 2-36 Exit
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@ Attention:
Save the configuration to server after tag modification, otherwise tag modification can't be
effective in the supervision.

For more details about tag build, refer to Tag Builder User Manual.

2.4.4 Custom Function Block Configuration

Functions or algorithms with the same logic and are frequently used in programs can be compiled
into custom function blocks, and then quoted in FBD program, to improve the readability and
efficiency of the program. Custom function blocks are compiled by programming languages of ST
and SFC. The operation method of custom function block is introduced with the example of ST
custom function block.

1. New Custom Function Block
Create a new custom function block within the VFExplorer, shown as Figure 2-37:

-4 Control Configuration

Elﬁ [0]Combustion

; El% [0.2]5team_Water
ﬁg Custom Program

@ Custom Function Block
ﬁ [1]1Centrol Demain Mew...

2B HMI . S
Operation Domain0 Compile...

Figure 2-37 New Custom Function Block

Select type ST, and Input name and description, shown as Figure 2-38:

Custormn Function Block ot
Name: | FLOW|
Type: sT =l
Description:

K | Cancel

Figure 2-38 input the name and description of custom function block

Double click the program name within the VFExplorer to enter the interface of custom function
block editor (VFSTModule).
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2. Add parameters

Add parameters of various types according to the requirements and set their initial value,
redundancy status, etc.

ﬂ‘ YFSTModule - INDBARATHPOWERNCOMBUSTION\STEAM_WATER[D.... = O >
File Edit Program View Help
= m &
=
1 Name Type Initial Value Relevant Param
| B N1 REAL 0.0000
E < >
oo
Parameter Type - X
Eqﬂ Pararmeter ~

BB gt Pormeigd

.3 INI: REAL Add N

..... A+ Output Parameter

----- A=} Inner Parameter

..... Configuration Parareter

..... A=F Supervision Parameters

..... 45k Operate Parameter

..... I8 Alarm Parameter

..... 4=F Temporary Variable v

Figure 2-39 add parameters

3. Edit program

For more details about programming syntax, refer to FBD Builder User Manual.

4. Compile

When custom function block edit is finished, it needs to be compiled in the VFEXxplorer, otherwise it
cannot be called in the FBD.

32



Project Guide User Manual

=- X Control Configuration
=] ﬁ [0]Combustion

ﬁi Custom P Open From Configuration Server
@ Custem Fi Save to Configuration Server
ﬁ [1]Centrol Domai Save to Configuration Server (Locked)
D HMI View
-2 Operation Domai o
Operation Domai Simulation
Operation Domai Save As

Load History Version...
Compile...
Download &IHHE

Figure 2-40 compile the custom function block

5. Call function block

Open a FBD program, select custom function block in the function block library to call the custom
function block. Application of custom function block is similar to the system function block.

1% VFFEDBuilder - INDBARATHPOWER\Combustion'Steam_Water[0.2] - [Combus... = O >
File Edit Program View Help
= sBReX aBEE oA gL EE kT we
#  Function Block Libranii - =
|Luukup Function Block Library j
|FLDW
* FLOW Mame Description |
0.00 _IIN1 OUT1 & FLOW
0.008 I IN2 ouT2_|
p0001 1# |
W
£ >
=
1
! % Compile /Find ", All Records /
Ready CAP |[MUM

Figure 2-41 call the custom function block

@ Tip:

For more detailed introduction of the custom function block configuration, refer to FBD
Builder User Manual.
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2.4.5 Custom Program Configuration

All functions including control loop, interlock control, polygonal line graphic, inter-station
communication, etc., can be realized in the custom program. The main types of the custom
program are FBD, LD, etc.

An FBD example to illustrate the process of editing custom program configuration is as follows:
1. New program
Create a new program in the VFExplorer, shown as Figure 2-42:

ER Control Configuration
¢ B [01Combustion
-7y [0.2]5team_Water

B Custor Prograa)
Aﬁj Custom Funct MNew... [}
- [1]Control Domain1 Compile...

58 HMI Import...

Operation Domain0
Operation Domainl

.25 Operation Domain2 Schedule...

Create Program in Batch

Figure 2-42 new program

Input name, type and description, shown as Figure 2-43:

Mew Custom Program >
Mame: | Combustion
Type: |FBD ﬂ
Description:

K | Cancel

Figure 2-43 input program name and type

Double click the program name to open corresponding custom program configuration in the
VFEXxplorer.

2. Add tags
(Configure the tags in the tag table before adding tags)

Add "Datalink" as Figure 2-44:
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1k VFFEDBuilder - INDBARATHPOWER\Combustion\Steam_Water[0.2] - [Combustion] e O *
| File Edit Program View Help
He@a® sd2eX & [@E = A oL BE B 2FLELIH -
#  Function Block Libran i - <
ILDukup Functicn Block Library j
| flowe
Marme | Description |
& FLow
O ?UNDEFINE? O
W
< >
x
1
l [4[ [ » [ #I[\, Compile /Find% All Records / 4] 3|
Ready MNUM A
Figure 2-44 select the type of quoted tag
Double click "Datalink" to select the tag required.
B 5 Tag Selection x
Tag Type .-C'-.I—.-C'-.nalug Input vI i ] ~| = Ef-
MName I Description I Address L]
E=] AI00020000 Standby 000-000-000-000
E=] AI00020001 Standby 000-000-000-001
E=] AI00020002 Standby 000-000-000-002
=] AI00020003 Standby 000-000-000-003
E=] AIN0020004 Standby 000-000-000-004
E=]AI00020005 Standby 000-000-000-005 o
< >
Nome |
Count  10/20
/ Cancel I
A

Figure 2-45 select tag

To select parameter of non-default type, click the button = after the selected tag. Selecting other
parameters within the tag is shown as Figure 2-46:
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B 5 Tag Selection >
Tag Type IAI-AnaIng Input j i I vI = "

Mame | Type | Description | Properties | [
ﬁ FLAG LDINT Flag READONLY
Process Variable Value | READONLY

& SWWSIM BOOL Simulation Input Switch

& SIMIN REAL Simulation Input Walue
ﬁ SWANM BOOL Force Switch READONLY
&SWDDS BOOL Switch of Out of Servi...
ﬁ SCH REAL Span Maximum READOMLY ™
MName | AIDOD20000.PV

Cancel I

Figure 2-46 select tag parameter
3. Add function block
Select function block library first, and select function block of required type, then move the cursor

to any place within editing area and click to add the function block. After the function block is
added, right-click any place within editing area to exit adding status, shown as Figure 2-47:

1 VFFBDBuilder - INDBARATHPOWERNCombustiontSteam_Water[0.2] - [Combustion] = O *
| File Edit Pregram View Help
deaa@| s2ex a@F=|lAscr BE|EEF 4 HLaF 3|0
#  Function GlocR LGSR - =
Lookup Function Block Library -
| Al00020008. PV Jl * PID I J
pid
0.00|_ BKIN MV _| |
ON|_/BKINERR ~ BKOUT _| Mame Description_|
| A00020021PY |yl oy prouTERR i PID General Pl...
& PIDEP PIDEP Fun...
0.00 & pIDEX Extended ...
0.00|ITV & piD_TP PID Functi...
- 0.00|_10A £ ePID EPID Contr...
& LEPD LEPID Fun...
p0004 1# v
€ >
=
4
l [4[ [ » [ #[s, Compile /Find® All Records / iK1 3|
Ready MNUM A

Figure 2-47 add new function block

4. Connection

Connect each output with input according to control scheme, and make sure connection from
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output to input.

Move mouse to output area of function block or tag, wait till a blue box appears (or mouse display
symbol "+"), shown as Figure 2-48:

== FID

[ AD00020000 BROUTE . }----n----- 0.00(IBKIN Mvr|— i ACO00020000.N |
" gl BKINERE BHOUT_|
0.00|JPY BKOUTERR.
0.00|CSV
| AIDDDZO000.FV | 0.00|JTV
OFF|_ISWTR
0.00|_loA

p0004 o

Figure 2-48 function block connection line 1

Then keep the left key of mouse pressed and start to drag the connection line, shown as Figure
2-49:

* PID

0.00|_IBKIN MV 4—| Ll ACO00020000.IN |
| AOQO00020000.BKOUTERR I—l ----------------- ' - BKINERR BKOUT |

0.00| PV BKOUTERR._|
0.00| ICSV

| AlD0020000 PV _-|-|—r 0.00|_ITV
OFF| ISWTR
0.00_|OA

p0004 3%

Figure 2-49 function block connection line 2

Drag mouse cursor to the input area of function block, and wait till the cursor becomes the state
shown as Figure 2-50, then release mouse to complete connection.

* PID

0.00(_IBKIN MV 4—| r AQ00020000.1N Ol
| ACO00020000.BKOUTERR l_l ----------------- 0 - BKINERR BKOUT |

8-86/4PV] BKOUTERR _|
0.00|_ICSV

| AlDD020000 PV —‘47 0.00|_ITV

OFF|_ISWTR

0.00|_IOA

p0004 3%
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Figure 2-50 function block connection line 3

5. Adjust the execution order of function block

The execution order of function block is determined by the label like 1# in the bottom right of
function block, according to the number order from small to large. If there is special requirement
for execution order, execution order of function block must be adjusted manually. Click the button

B {5 enter function block order adjusting status. Execution order of the function block can be
adjusted by clicking the blue area of the function block in the execution order, shown as Figure
2-51.

15 VFFBDBuilder - INDBARATHPOWER\Combustion\Steam_Water[0.60] - [Combustion] = O *
File Edit Program View Help
H @a e o EEE = AR Q1 mE o= @
~  Function BlocEEEN - >
|L00kup Function Block Library j

|add

= ABS
* PID @ Ldrine ouTr r"l" AOCD0020002.IN J| Name Description |

0.00|JBKIN v 007 2% 4 ADD ADD Funct...
ON|_IBKINERR BKOUT |
0.00| PV  BKOUTERR.| & ADD3 HElEnNE
000 B8 ADDINT  INT Additi...
0007V & ADDUINT  UINT Addi..
OFF|ISWTR * ADD & mapD Matrix Ad...

riNZ

pOO0E 3%

W
>

Cifpil -~ * A

" Compile /Find %, All Records /

NUM

Ready

Figure 2-51 adjust the execution order

6. Compile

download will be failed.

7. Program scheduling

Program scheduling is to adjust the execution period and initial phase of the program. Normally,
the default setting is adequate, but if there is any special requirement for program execution period
(e.g., requiring the program to run in fast period), the period can be adjusted; if there are too many
programs running in one phase of the controller and cause the phase overloaded, the initial phase
can be adjusted. The phase is modified as follows:

Right click the program needed to adjust, and choose "Property", shown as Figure 2-52:
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E--@ INDBARATHPOWER MName | Description | 1D | Last Modified Time | Prigrity | Cycl
Ceonfiguration Server
----- Comrmon Settings Edit...
[]-- Systemn Function Block Library Compile
Global Function Block Library Delete

Phase Class Library

----- [ Program Template Library
[—]% Control Configuration
= [0]Combustion

: E| % [0.2]5tearm_Water

Figure 2-52 program property

..... @ Custorn Program

MNew Password

Wiew Content to be downloaded

| Popertie |

Program property dialog box pops up, shown as Figure 2-53. Program running period and initial
phase can be adjusted in the dialog box.

Custom Program Properties

Mame: Combustion

Description: | temperature compensation calculation|

Cyde: |1 ~ | Multiple StartPhase: |1 «|  Priorit|Medium

QK | Cancel |

Figure 2-53 adjust the period and phase of program

If there is special requirement for execution order of programs within the same phase, right click
the custom program and choose “Scheduling” in the right-click menu, shown as Figure 2-54:

B- x Control Configuration
: =1 ﬁ [0]1Combustion
g- ﬁ [0.2]5team_Water
..... @ -
----- @ Custom Fune
i ﬁ [1]Control Domainl
E| HMI
- Operation Domain0
Operation Domain’
Operation Domain2

New...
Compile...
Import..

Create Program in Batch

Schedule...

Figure 2-54 program scheduling

The execution order of programs within the same phase can then be adjusted. The program is
executed according to the order of their name in the list. For example, in the following figure, when
the execution phase is 0, the program "Combustion" will be executed first, then the program
"Steam&Water". Click button "Shift Up" or "Shift Down" to adjust the execution order of selected

program.
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Regulate Sequence of Custom Program >
FastCyde [ Phase: |0 - |
Combustion
Steama&Water

Cancel

Figure 2-55 adjust the program execution order

j Tips:

® For more detailed introduction of custom program configuration, refer to FBD
Programming Software User Manual.

® For instruction of single function block, refer to the corresponding function block user
manual.

2.4.6 Download Wholly

This system adopts the download method of on-line or off-line. On-line download is to download
increasingly by single whole control station. The software will check whether the configuration
version of the controller is in accordance with the version downloaded last time. If not, it prompts
off-line download. On-line download only downloads the configuration modified, and have no
influence on unchanged configuration. Off-line download is to download all configurations to the
controller and may cause disturbance during download, so off-line download should be carried out
cautiously and normally on-line download is adopted.

Download must be carried out in the VFEXxplorer. Before download, make sure that hardware
configuration, tag build and program compiling are correct.

The processes of on-line download and off-line download are similar. Choose the controller
requires configuration download, then choose the download method in the editing menu. (Right
click the controller and choose "Online Download" in right-click menu to download online), shown
as Figure 2-56:
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E VFExplorer - INDBARATHPOWER = O X
| File | Edit Debug View Help
J |:|l Open from Configuration Server Ctrl+D j i | % @_ | . "i}
=851 | Bl Saveto Configuration Server Ctrl+5 | Description | Last Modified Time | Path
Save to Configuration Server (Locked) m Program DAECSDatahIh
----- View m Function Block DAECSDatanIM
[~ Import Configuration of Control Domain... vare Configuration 2021-07-14 1&:51:30  DAECSDatat M
New Configuration of Control Domain... able 2021-07-1416:57:27  DAECSData\IM
ontrol DAECSDatat Il
..... i DAECSData\Ih
B Load History Version...
Compile...
% Download Offline... g
Upload Parameter...
B @ Mew Custom Program... Ctrl+MN
% Mew Custom Function Block...
Custom Program Scheduling...
B Open VFHMICHG...
i Publish Configuration...
7 Delete Delete *
#y Find... Ctrl+F

x
Figure 2-56 choose download method

The following dialog box pops up.

Download

Downloading Industry Function Blodk[Piece: 256 ~ 383]...
Succeeded to download Industry Function Block[Piece: 256 385
Downloading Industry Function Blodk[Piece: 384 ~ 511]...
Succeeded to download Industry Function Block[Piece: 384 rn 511
Downloading Industry Function Blodk[Piece: 512 ~ 527]...
Succeeded to download Industry Function Block[Piece: 512 ~ 527
Deleting hardware configuration. ..
Downloading hardware configuration. ..
Deleting tag configuration. ..
Downloading controller[0. 22] custom program scheduling list...
Deleting all custom programs. ..
Downloading custom program parameter initial value. ..
Downloading parameter textl initial value. ..
Downloading textl...
Succeeded to download text1!
Updating program status...
Downloading overall configuration information. ..
Disconnecting with controller[0.22]...
Activating FF segment...
FF configuration downloads error records:

[MODULE: 0-0-0]Failed to scan devices, can not connect to the H

Controller I.’J.;EHZ download successﬁ.llli!

< >

[T Unlock

W

|

Start to connect controller. ..

Reading controller[0. 23] status timeout and please resend!

Reading controller[0. 23] status timeout and please resend!

Read controller[0. 23] status timeout, please check network and try ac
Start to connect controller. ..

Reading controller[0. 23] status timeout and please resend!

Reading controller[0. 23] status timeout and please resend!

Read controller[0. 23] status timeout, please check network and try ac
Start to connect controller. ..

Reading controller[0. 23] status timeout and please resend!

Reading controller[0. 23] status timeout and please resend!

Read controller U.iﬂ status ﬁmenutiiease check network and tri ac

Download. ..

Figure 2-57 download dialog box

Click "Download" to download the configuration.
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@ Tip:

For more detailed introduction about downloading, refer to Config Explorer User Manual.

2.4.7 Save Configuration to Configuration Server

After editing is finished, normally configuration of control station should be saved to configuration
server, otherwise other engineer station can't operate with the station, and the tag information, etc.,
cannot be transmitted to other operation node timely.

Before saving, make sure that there is no error in hardware configuration, tag build, program and
the VFIOBUuilder, VFTAGBuilder, custom programs, etc., are closed, otherwise it would be unable
to save. Saving procedure is shown as Figure 2-58:

"= VFExplorer - INDBARATHPOWER - O >
File Edit Debug View Help

i EL RS ~n 2 @

-2 INDBARATHPOWER A | Name | Description | Last Modified 1
Configuration Server ﬁgCustDm Program
""" Common Settings @Custu:um Function Block

EEI" Systemn Function Block Library WM Hardware Configuration 2021-07-14 16:!

Global Function Block Library Tag Table 2021-07-14 17"
Phase Class Library Unit Control
----- B Program Template Library IEFF List

[_]% Control Configuration
=g [0]Combustion

@ Custom P Open From Configuration Server
: ‘@ Custom Fi Sawve to Configuration Server
i >
""" & 1Cantrol Damai Save to Configuration Server (Lu:ucke%

View
Simulation

Save As..,

Load History Version...

Compile...
\, D”tP”t.-'{Fm': Download Online...

Output BErI— -

Figure 2-58 save configuration to server

L,jj__l Tip:

For more detailed introduction of saving configuration to server, refer to Config Explorer
User Manual.
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2.5 Global Function Block Configuration

Global function block can be used in any control station (instance). There are three levels in global
function block library:

® Global Function Block Library

® Global Function Block Folder

Global function block folder can contain several global function blocks and manage
them.

It supports operations of New, Delete and Import Function Block.

® Global Function Block

Global function block consists of Parameter, Logic, Symbol and Panel, and supports

several symbols or panels.

The graphics of global function block configuration shows as Figure 2-59:
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Compile Failed
Return to

Specified Step for gl

Modification

Glohal Function Block Canﬂguratiaf:]

Create Global Function Block Folder

Y

Create Global Function Block

-

— —pu EditGlobal Function Block Logic

r
|
i
|
!
|
|
!
!
——s=| EditGlabal Function Block Panel
!
!
!
|
|
|
|
|

-

Create Global Function Block Panel

-

-

Create Global Function Block Symbal

-

= =ge-{ Edit Global Function Block Symbaol

v

Configure Global Function Block Parameter

Compile Global Function
Block

Instance

L4
=

'

Use VFExplore

Use VFSTModule

Use VFExplore

Use VFPanel

Use VFExplore

Use YFSymbol

Use VFExplore

Compile Successfully

Use VFFBDBuilder

Figure 2-59 Graphics of global function block configuration

2.5.1 Create Global Function Block Folder

14. Right-click “Global Function Block Library” and select “New” in right-click menu.

15. Input name and description of the global function block folder in the dialog box shown

below.

Mew Custom Function Block Library >

Marme:

Description:

QK | Cancel
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Figure 2-60 New global function block folder dialog box
® “Name” contains at most 16 capital letters, numbers or underlines.

® ‘“Description” contains at most 64 capital letters, numbers or underlines.
2.5.2 Create Global Function Block
16. Right-click “Global Function Block Folder” and select “New” in right-click menu.

17. Input name and description of the global function block, and select its type in the dialog
box shown as below:

Mew Function Block =
Mame: | G_
Type: |FBD j
FED
Description: |ST

QK | Cancel

Figure 2-61 New global function block dialog box

® “Name” contains at most 16 capital letters, numbers or underlines.

® “Type” can choose “FBD”, “ST” or “SFC”.

® “Description” contains at most 64 capital letters, numbers or underlines.
2.5.3 Configure Properties of Global Function Block

1. Edit Logic of Global Function Block

2. Select “Logic” in the configuration property bar of global function block, and select “Edit”
in the right-click menu.

3. Pop up VFSTModule.
4. Edit the logic of global function block in VFSTModule.

Details of VFSTModule see FBD Builder User Manual.

Edit Parameter of Global Function Block (selectable)

1. Select “Parameter” in the configuration property bar of global function block, and select
“Edit” in the right-click menu.

2. Pop up Properties Settings dialog box shown as below. Set macro of the global function
block in “Macro”, which can contain at most 10 English letters, numbers or underlines,
and it only can be started by character.
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Properties Settings >

Basic ]Extended l Alias l Macro l

MName | Type | Initial Va... Description
= Input Para... Input Parameter
- 1 REAL 0.0000
L m2 REAL 0.0000
E- Qutput Pa... Output Parameter
L oum1 REAL 0.0oo0

Cancel

Figure 2-62 Global function block properties settings dialog box

“Basic Parameters”, “Extended Parameters” and “Alias Parameters” can only view but
not modify the parameters.
Create Panel of Global Function Block (selectable)

1. Select the specified global function block in work space, and select “New Panel” in the
right-click menu.

2. Pop up the “New Panel” dialog box shown as below, input the “Name” and “Description”.
The panel name can contain at most 12 characters. It cannot be empty or contain any
blank space and symbols like V:*?\"<>||@#$%"&=,.";[]+-~.
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Mew Panel ot

Mame: SFCP

Description: | sF¢ Global Function Block Custom Panel|

QK | Cancel

Figure 2-63 New global function block panel dialog box

3. Pop up VFPanel after clicking “OK”.

4. Set the global function block panel in VFPanel.

Details of VFPanel see Graphics Builder User Manual.

Create Symbol of Global Function Block (selectable)

Select the specified global function block in work space, and select “New Symbol” in the right-click
menu.

Pop up the “New Icon” dialog box shown as below, input the “Name” and “Description”. The
symbol name can contain at most 12 characters. It cannot be empty or contain any blank space
and symbols like V:*?\"<>|!@#$%"&=,.";[]+-~.

Mew Symbol =

MName: SFCS

Description: | sFc Global Function Blodk Symbol

0K | Cancel

Figure 2-64 New global function block symbol dialog box

Pop up VFSymbol after clicking “OK”.
Set the global function block symbol in VFSymbol.
Details of VFSymbol see Graphics Builder User Manual.

2.5.4 Compile Global Function Block

Select the global function block in work space and select “Compile” in the right-click menu.
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2.6 FF System Configuration

When FF system is included in project, it is necessary to configure the FF devices, control strategy,

etc.

FF system configuration can be divided into two parts: offline configuration and online
configuration. During the implementation of project, offline configuration can be performed at the
plant first, and online configuration operation is performed after system is physically installed in the
field and the FF device is physically connected. The specific FF system configuration process is

shown in Figure 2-65.

FF System Configuration\;l

FF H1 Interface Module
Configuration

.

Virtual FF Device
Configuration

.

FF Mapping Function Elock
Associagtion Configuration

.

FF System Control
Strategy Configuration

LoneanSyuoT auno

:

Canfigure Block
Farameters of FF Device

;

HMI Configuration

FF Device Matching

;

Zonfiguration Release

'

iZontrol Configuration
Download

HOIEINBULOT SUNUD

;

Configuration Backup

;

End

}Use Hardware Configuration Software

} Use FF Configuration Software

lUse Function Elock Diagram
Frogram Software

J

Use FF Configuration Software

} Use WFHMICfg Software

Use FF Configuration Software

}Use VFExplore Software
] lse System Structure
['Configuration Software

Figure 2-65 FF system configuration graphic
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2.6.1 Configure FF H1 Interface Module

OMC system communicates with FF devices on FF H1 network through FF H1 interface module
(hereinafter referred to as AM712-S). AM712-S configuration must be completed first to perform
the FF system configuration. The configuration of AM712-S is done in the hardware configuration
software of High-performanceHMI.

It is necessary to complete the creation of OMC system engineering and carry out the system
structure configuration before AM712-S is performed.

The configuration process of AM712-S includes:

1. Start hardware configuration software in configure management software. Please refer to
Hardware Configuration Software for details.

2.  Add AM712-S to specified rack according to the design requirements of system hardware
structure, as shown in .

[l VFIOBuilder - INDBARATHPOWER\Combustien' Control Station_172_20_0_22[0.22] — O X

Eile Edit Operation Debug Wiew Help

H 2R D o X B S D

Workspace » x |B Configuration
Address ooo
022 712-§ * —
B [02)FCun2-s - Model AM712-5(P)
E-s [000]COMT701-5 * Narme FF Interface Module
=1 [000]CNT21 Description
o A [0D0]AMT12-5(P) * Rermark
Redundancy Yes
Systermn Power Consumption{W) 2.40  (0.1000A * 24V)
Auxiliary Power Consurnption (W) 0.00  (0.0000A * 24V)
Hardware Configuration Tree ‘
Ready Channel: 32/32 NUM

Figure 2-66 Add AM712-S

@ Tip:

If AM712-S is already installed in the rack and control system is powered on, user can scan
upload function to scan and upload the actual connected hardware in current system to
obtain hardware configuration information.

Please refer to Hardware Configuration Software for details.

2.6.2 Configure Virtual FF Device

Virtual FF device refers to the device that is selected by configuration software from vendor list
and added to device configuration. Virtual device also needs to be physically connected before it
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can work normally in system.

User can add FF device used in FF system to be specified FF H1 network, and specify the device
tag and its address in FF H1 network for the virtual FF device by configuring a virtual FF device.

The following steps can be used to configure the virtual FF device after completing AM712-S
hardware configuration.

1. Start VFFFBuilder
Select specified AM712-S in hardware configuration software, and select
"Communication Configuration" in its right-click menu to start VFFFBuilder software. The
interface of software is shown in Figure 2-67.

2. Add virtual FF device
As shown in Figure 2-67, select the vendor, type and version of required device from
vendor list window of software interface and drag it into the "Commissioned Fieldbus
Devices" of device configuration window.

ﬁ VFFFBuilder - [INDBARATHPOWER\ Combustion\Caontrol Station_172_20_0_22[0.22]202020] — O >
B File(l Window(W] Advanced(&4] Help(H) J

Manufacturer List

f-@] Ronan Engineering - (3152

738 ROSEMOUNT AMALYTICAL DIVISIO
-] Rosemount Inc. - 0x001151

B 0644 - 644

B8 0752

i-0F 3244 -
o8 3900 -
o8 5300 -
BB 5400 -
i-F8 5600 -
v-E8 5900 -

- 752 Fieldbus Remote Disp

B 020101 -752

-752
- "848 Fieldbus Temperatur
- 2051 Fieldbus Pressure Tri
- 2088 Fieldbus Pressure Tri
- Resemount 2230 Graphici
- 2240 Temperature Multip
- 3051 Fieldbus Pressure Tri
- 3095MV Fieldbus Transmi
- 3144 Fieldbus Temperatu

3244 Fieldbus Temperatu
3900

T2

5400 TankRadar SENTRY |
5600 TankRadar PRO Leve
5900 Radar Level Gauge

X Device Configuration
- E--@ [0O0]AMT12-5(P) H1 Module

Mame

LE’:’J Segment0
|£q, Commissioned Fieldbus Devices

: .84 DeCommissioned Fieldbus Devices
A 7 = Segmentl
ﬁq Commissioned Fieldbus Devices

.84 DeCommissioned Fieldbus Devices

== Segment)
== Segment]

< >

Output b4

2021-07-14,18:24:50 Failed
2021-07-14,18:25:04 Failed
2021-07-14.18:25:18 Failed

f-CB 752 - 752 Fieldbus Remote Displi
2 P2 A0 - 2A8) | nnic Fisldhos Trane ¥

B
B
[
&
£
£
£
&
m-E8 3151 - 30515MV
&
£
£
£
B
&
[
o

< > Status/ Ope../ Error
Ready CAF |NUM |SCEL

Figure 2-67 Add FF device to FF network segment

3. Set FF device properties
Enter the address and device tag in the pop-up dialog and it means that the addition of
configuration meter is completed.
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@ Tip:

The detailed configuration description of virtual FF device configuration can be found in FF
Configuration Software User Manual.

2.6.3 FF Mapping Function Block Association Configuration

The association between FF device function block and FF mapping function block in
High-performanceHMI system software is established by FF mapping function block association
configuration.

The configuration of OMC system project, AM712-S hardware configuration, and FF device are
required before FF mapping function block is configured.

The configuration process associated with FF mapping function block includes the following steps:

Serial Number Process

1 Create FBD Custom Program

2 Start Function Block Program Software

3 Add FF Mapping Function Block to Control
Program

4

FF mapping function block is added to control
program in VFFBDBuilder software. Specific
steps are as follows:

1. Select function block required by control
strategy in the right function block library
window.

2. Drag the selected FF mapping function
block to program area.

Set FF Mapping Function Block Tag

5 Assign FF Tag

Create FBD Custom Program

Select specified control station on configuration tree of configuration management software and
place it in local lock status.

1. Select "Custom Program" of control station and select "New" in its right-click menu.

2. Enter program name and description in the pop-up "New Custom Program” dialog and
select "FBD" as program type.
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For specific operation interface and operation methods, please refer to "Custom Program™ in
Configuration Management Software.

Start Function Block Program Software

Select new program, and double click to open the function block program interface, as shown in
Figure 2-68.

15t VFFEDBuilder - INDBARATHPOWER\Combustion\Control Station_172_20_0_22[0.22] - [text1] — O b
-
S—
File Edi Program View Help ~Title
= cyeNC! w(EE =aAk gl WE 4 8 @
3 \ A Function BlocREFIN - ~
Menu Bar |FF Standard Function Library |
Toolbar
| »
b
Name Drescription ~
£ Fral S
= earch Box
& FFAD
& FFARTHM  FF Arithm...
= FFRID & FFCTLSL FF Control...
= FFAI ST =] & FFCUSTOM  FF Custom
ourr—l 0.00|ICSV BKOUTT * FFAC &

p0002 2% 0.00(_IN |-h|’CS‘u" ouUT_| i Funcuon BIOCk

<Unsssigned> 0.0 el t: Library Window
0| JSWTR p0003 3 !
o001V <Unsssigned> £ FFISELEX  FFExtem ..
Program Area pOc 18 £ FEMAI FF Multipl...

<Unassigned>

& FFMAO FF Multipl...
& FrvDI FF Multipl...
& FFMDO FF Multipl...
& FFPID FFPID
¥ |& FrsGCR FE Signal ..
< v fit_EEspLIT EE Obrt hd
X
p .
Qutput Window Status Bar
l '\ Compile {Find}, All Records / / |
NUM

Ready

Figure 2-68 Function block program interface

Add FF Mapping Function Block to Control Program

FF mapping function block is added to control program in VFFBDBUuilder software. Specific steps
are as follows:

3. Select function block required by control strategy in the right function block library
window.

4. Drag the selected FF mapping function block to program area.

Set FF Mapping Function Block Tag

Set FF mapping function block tag in VFFBDBuilder software. Specific steps are as follows:

1. Double click on the FF mapping function block to be named, and "Property" dialog in
Figure 2-69 is displayed.

2. Enter tag name of function block in "Name" text box.
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FF PID x
Property l Basic ] Extended
Mame FFRIDODY
Input Status {8} o
Qutput Stakus + )
Description
Tag Group |[DD] Tag Group 0 j
Tag Level |D j
Decimal Digits 2 =l
Panel |* j
FF Subcycle |1 j
oK | Cancel Help

Figure 2-69 Function Block Property Settings dialog
Assign FF Tag

Users can assign the fieldbus shadow function block in High-performanceHMI system software to
the fieldbus device in the field by the FF tag assignment.

1. Select the function block, right-click and select Assign FF Tag, open the Assign FF Tag
dialog.
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B Assigh FF Tag >
FF Interface el - -
Mol | 0o0-002-000 227 _2 x| b - =
Device Mame | Segment
POTI
FOTZ segment-0

] | [*]

Marne IF‘DTI ok__|
Tag 2 Cancel I

Figure 2-70 Assign the Tag of Fieldbus Shadow Function Block to Device

2. Select the device and click "OK" to open the following dialog.

B Assigh FF Tag >
FF Interface s - -
i | ooo-002-000 227 _2 | & |«
Function Block Marme | Function Bloc... | Whether iz agsigned
POT1_FFFID3 FFRID Linassioned

‘| | D

Name [PDTI/PDTL_FFFIDS ok
Tag 1 Cancel I

Figure 2-71 Assign the Tag of Fieldbus Shadow Function Block to function block of Device

3. Select the function block and click "OK".
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j Tips:

FF mapping function block association configuration is completed in VFFBDBuilder
software. Please refer to VFFBDBuilder Software User Manual for details.

Foundation Fieldbus System Control Strategy Configuration Application

FOUNDATION fieldbus control strategy configuration can be completed in the VFFBDBuilder.

1. Invoke the function blocks (such as global function block, system function block and
Fieldbus shadow function block) in VFFBDBuilder.

2. Execute FF Mapping Function Block Association Configuration.

3. Link the function block according to the control strategy.

The FOUNDATION fieldbus control strategy consists of field control strategy and mixed control
strategy.

® Field Control Strategy
Figure 2-72 shows an example of field control strategy, in which all function blocks
performing the control strategy are fieldbus shadow function blocks and must be invoked
from the fieldbus shadow function library when programming. The control strategy will
run in the field devices after being configured and downloaded.
The scheme of control strategy shown in Figure 2-72 in VFFBDBuilder is shown in Figure

2-73.
Transmitter Valve
] —
eg?, - :| BKCAL_IN BKCAL_QUT
| : OUT[ ]m OUT[ :ICAS_IN
T 4 FFAI TFPID IFFAQ

Figure 2-72 Field Control Strategy
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Figure 2-73 Field Control Strategy in the VFFBDBuilder

Mixed Control Strategy

Figure 2-74 shows an example of mixed control strategy, in which the function blocks
performing control strategy include fieldbus shadow function block and DCS algorithm
function block. The mixed control strategy can be executed by combining fieldbus device
and control system.

The scheme of control strategy shown in Figure 2-74 in VFFBDBuilder is shown in Figure
2-73.

St
1 eam

FT101 | ———

N

CAS
SP TIC100) /™ T ‘1

Product
h h
Figure 2-74 Mixed Control Strategy
FFPIDOT FFADDT
FID001 FFFID FFAD
PID rBKIM M FCSY OUT
FFAIDZ JIBKIN el rCSY  BKOUTY BKOUTC
FFAI JEKINERBKOUT | I pO003 8
ouTr Py BKOUTE.. 2 JFF sal POT1/POT] FFAQZ
p0005 E& p0004 FiE J%WR
POTZ/POTZ2 FEANS d
FFADT P02 L
FFAI POT1/PDT1 FFPID
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pOD01 T2

POT1/POTT FRAN

Figure 2-75 Mixed Control Strategy in the VFFBDBuilder
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2.6.4 Configure Block Parameters of Fieldbus Device

The block parameters of fieldbus device can be configured in the VFFFBuilder.

1.

2.

ey

Select the fieldbus device in the Device Configuration window of VFFFBuilder, right-click
and select Device Configure to open the following dialog.

Device Configuration

MANUFAC |n,h,,,.:mms PD-Tag {Device Infarmation Display Area JyER |M2
DEV_TYFE IFisher DVCBO0OT- €  Node Addr |um Davice ID {005100B000FisherCvCO0502060.

= Ll FISHER,_4601
=0 POTI_FFREZZS
B3 parameter
+ 5l Method
+- POTI_FRCUS24
= @ POTI_FFAN3
+ |G POTI_FFMATL4
+- [ POT1_FFAOIS
+ [ POTI_FFONI6
& poT1_FFONI7
+ [ POT1_FFOLIB
= [ POTI_FFON9
% [ POTI_FFDOZ0
+ [0 POTI_FFRIDZI
+- @ POT1_FFISELZ2

= U enT1 EESEITZS

& Property | B Contsined| B2 Mlam |

Pararmater Name: | Parameter vaius |
Wl Exeo
abl

[Blnck Parameter Configuration Area]

IEIIDck Parameter Selection Area]

EE

[F'arameter Instruction Areal

Figure 2-76 Device Configure Dialog

Click Apply after modifying the parameter.

Tips:

® Details for the block parameter configuration of fieldbus device refer to the
VFFFBuilder Software User Manual.

® Details for the block parameter of fieldbus device refer to the fieldbus device user

manual.

2.6.5 FF Device Commission

Users can commission the fieldbus device in Commissioned Fieldbus Devices with the online
fieldbus device. Only the commissioned fieldbus device can be managed and monitored in the

system.

ey

Tips:

FF device matching is implemented in VFFFBuilder. Please refer to FF Configuration
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Software User Manual for details.

Configuration of virtual FF device needs to be completed before FF device is matched, and FF
device is already online.

Steps for matching FF devices include:

1. Select the online fieldbus device in the Decommissioned Fieldbus Devices, right-click
and select Put in Standby.

Device Configurakion X

=- 8% [000]aM712-5 H1 Module
& .25 Segmentd
Elﬁg Commissioned Fieldbus Devices
. iy ABE_ODIF_E
-y AEB_OD1F_A
- -4 FISHER 4601
-k DeCommissioned Fieldbus Devices

[F]-== Segmentl Device Configure

- Commissiong

Ut in Standby

o =ldh DeCarmmissi Put in Standb
Make Spare
Sek PD-Tag
Diagnostic
Property

Figure 2-77 Put the Online Fieldbus Device in Standby

2. Select the configured and decommissioned fieldbus device in the Commissioned
Fieldbus Devices, right-click and select Commission.

Device Configur ation X

=B [000)aM712-5 H1 Module
# .z Segment

E% Zommissioned Fieldbus Devices

. Wy ABE_ODIF_B
-ty ABB_DD1F_A

e

Ec&ﬂ D armnm
ERFISH  Delete

=== Segmentl —————————————
Sy Commissi Property s
Lol DeCommissioned Fieldbus Devices

Cammmission

ices

Figure 2-78 Commission the Fieldbus Device

3. The Select Device dialog appears. Select the fieldbus device in the Device List. Dragging
the fieldbus device form the Decommissioned Fieldbus Devices to the Commissioned
Fieldbus Devices can also achieve the commission.
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Select Device x|

Device List

Device ID; 000320001F0000003kKE5113305215355

Mode Addr: Oxed

Ok

Figure 2-79 Select Device Dialog

2.7 Supervision Configuration

Supervision configuration includes operation domain configuration and operation team
configuration. Operation domain configuration mainly includes operator's authority configuration,
alarm color setting, domain variable configuration, history trend configuration, customized alarm
grouping, panel authority, shelve alarm, manage state, procedure, etc.; operation team
configuration mainly includes overview display, data summary display, control group display, trend
display, graphics, report, scheduling, custom key, alarm region, alarm panel setting, alarm sound
setting, tag associated graphics configuration, tag associated trend display, etc.

j Tips:

® For more detailed introduction of supervision, refer to HMI Config Software User
Manual.

® For more detailed introduction of supervision user authority, refer to User Access
Software User Manual.

® For more details of report configuration, refer to Report Software User Manual.

® For more details of domain variable configuration, refer to Domain Variable Config
Software User Manual.

2.7.1 Open Configuration

Supervision configuration is locked by unit of operation domain (not including resource files), and
an operation station can only be locked and edited by one engineer station Open the operation
domain from configuration server before editing it, otherwise it is only available for viewing the
configuration or editing the resource files. Make sure that the engineer has the authority to
configure the operation domain; otherwise the configuration domain can't open.

Select an operation domain in VFExplorer and click "Open from Configuration Server” in the
right-click menu to open supervision configuration software (VFHMICfg), (Right click and choose
command "Edit" in the right-click menu, can also lead to the operation domain configuration
interface), shown as Figure 2-80:
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Bl vrHmMICEg — | *

Eile Edit Yiew Operation Help

FH R AR XFEOERE BP0 e J486EE| "
-5ty Operation Demaind

..... @ Operation Teamn

EI@_'.-] Demain Configuration
----- I8 Domain Variable
..... I® User Authority
..... History Trend
----- {2 Custom Alarm Group
«ﬁ Panel Authority
..... i= Alarm Shelving
----- (¥ State Management
..... % Alarm Help
- Resource Files

Ready DMECSData\INDBARAT

Figure 2-80 supervision configuration interface

2.7.2 Domain Configuration
1. Monitoring user authority

Supervising user authority is aimed at assigning the corresponding authority to the operator of the
operation domain. Only the users assigned here can login the supervision.

1. Double click the "User Authority" under the "Domain Configuration", pop up the
configuration interface of the user authority.

2. Two users Admin and Observer already exist in the user authority configuration interface.
Users of required level can be added according to demand. E.g., add an engineer user
with all the authority of corresponding level. Select the engineer node on the left, and
choose the Add User command.

3. Choose Local User as the User Type and input User Name in the interface:
Maintenance engineer; User Description: maintenance engineer; Password: 1111.

4. Click the button "OK" and the user “MaintenanceEngineer" would appear under the
engineer rank, as Figure 2-81:

60



Project Guide User Manual

U VFAccess

Operation Manage View Help

=H £ “n ‘FE

1 User Management

MName

Level

[—j% Privilege+
.4 Admin

------ % Privilege

------ % Privilege-

------ % Engineer+

El%
MaintenanceEngine

------ % Engineer-
------ % Operator+
------ % Operator

------ % Operator-

E% Observer
Q Obs=erver

£ >

Ready

MaintenanceEngineer

<
User List /

Engineer

MUM

Figure 2-81 Complete creating a new user

5. Select the user "Maintenance_engineer" in the left directory tree and choose the page

"Data Group" to select tag groups available for user operation, as Figure 2-82:

I vFAccess O >
Operation  Manage View Help
= X fp I @)
{::I User Management Combustion Enable Tag | Contrel Demainl | Enable Tag | ~
El% %ViligE+_ [] Tag Group 0 J [ Tag Group 0 J
...... % Privileg:m [ Tag Group 1 | OTeg Group 2l
...... 2 Privilege- [] Tag Group 2 | i Tag Group 2 2]
------ 2> Engineer+ [] Tag Group 3 J [] Tag Group 3 J
El% Engineer ) [ Tag Group 4 J ] Tag Group 4 J
...... @....fgi:i:rtenanceEnngI [ Tag Group 5 J ] Tag Group 5 J
...... % Operator+ [] Tag Group & J ] Tag Group & J
...... % Operator [] Tag Group 7 J [] Tag Group 7 J
""" % Operator- [] Tag Group & J ] Tag Group & J
El% Lisan [] Tag Group 9 J [] Tag Group 9 J
Q Cbserver [ Tag Group 10 J [] Tag Group 10 J
[] Tag Group 11 J ] Tag Group 11 J
[ Tag Group 12 J [] Tag Group 12 J
[] Tag Group 13 J ] Tag Group 13 J v
< > User List}' Data GroupA/ProcessIAIarm Group AckAuthority}‘ Superl\.risor}r Operation
Ready NUM

Figure 2-82 Data grouping

settings
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this user chooses to supervise.

I vRAccess = O >
Operation  Manage View Help

CIEEEIREE

{::—l User M_ar_‘lagement Operation Authority | A
[—]% Prwllege+_ ] Exit System
Q Admin -
______ % Privilege [] View System Status
...... % Privilege- [] Screen Copy Print
------ %> Engineer+ [] Open Operation Log
[_]% Engineer [] View All Operation Reco
Q MaintenanceEngine Sustern Hotk
stem Ho
------ % Engineer- Loy =
______ % Operator+ [] Process Alarm Shielded
...... % Operator [] System Alarm Shielded
------ % Operator- [ Alarm ACK
EI% fleeie [] Report Browse
Q Ohserver —
[] Electronic signature ope
[] Electronic signature veri
[] Alarm Print
Report Print
D, P o v
4 » Data Group }\ Process Alarm Group Ack Authurit}r}\ Supervisory Op
Ready MU

Figure 2-83 Supervisory Operation Authority settings
7. Users of other level can also be added according to requirement. After all users needed

are added, check the operation teams to which this user has access, then save and exit
the user configuration interface.

j Tip:
It's recommended to select the operation teams to which the user has login access after
completing all the configuration of operation team.

2. History tend configuration

If the history trend of a measuring point needs to be recorded, tag build should be carried out in
“History Trend”

Double click the "History Trend" under "Domain Configuration”, pops up the history trend

configuration software (VFHisCfg). Click the button 3 on the toolbar and pops up the tag
selector. Select the tags need to be recorded, and set the period, configuration of trend library tags
in this domain can thus be achieved.

Right click: “History Data Server" to choose "Add History Data Server", and select the operator
station (or engineer station) serves as history data server, shown as Figure 2-84:
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Operation Domain0

Station Mame: |Hismry Data Server 0000

Operation Mode (IF)

[[]server_1_15a(1.158)

Data Reserved in Database: I 366 day(s)(0 represents not to delete)

Cancel |

Figure 2-84 add history data servers

Then allocate the tag groups to history data server according to the load of the servers, shown as

Figure 2-85:

@] VFHisCfg _ O >
| File View Tool Help

R A

History Trend Configuration | Combustion IControI Domain] I ~

El--% Operation Domain0
.42 History Trend Tag

=58, History Data Server

£ >

Ready

[0]Tag Group 0 (0)
[1]Tag Group 1 (0)
[2]Tag Group 2 ()
[3]Tag Group 3 (0]
[4]Tag Group 4 (0]
[3]Tag Group 5 (0)
[6]Tag Group & (0]
[71Tag Group 7 (0]
[8]Tag Group & (0]
[%]Tag Group 9 (0)

[1[01Tag Group O (0
[][1]Tag Group 1 (0)
[][2]Tag Group 2 (0]
[1[3]1Tag Group 3 (0
[1 [41Tag Group 4 (0]
[1[5]1Tag Group 5 (0
[] [6]Tag Group & (0]
[][7]Tag Group 7 (0]
[1[8]Tag Group & (0
[1[91Tag Group 9 (0)

[10]Tag Group 10(0) [ [10]Tag Group 10 (0]
| [111Tag Group 11 (07 [ [111Tag Group 11 (00 ¥

B |

Figure 2-85 history data server settings

3. Custom alarm grouping
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Alarm grouping includes default ones and custom ones. Default alarm grouping is tag grouping. If
there is any special alarm grouping requirement, it can be configured in the custom alarm group.

Double click "Custom Alarm Group" under "Domain Configuration" to configure the alarm group.

Custom Alarm Group %
Alarm Group: j J Selected Tag: | Find Optional Tags: 160 [ 160
= . T Tag Name Filter:
Add Alarm Group L\\, Control Domain: All -
Delete Alarm Group Control Station: Al -
Add Alarm Region Tag Group: Al hd
Tag Type: ’m Clear Filter
Shift Up
Shift Down Tag Name | Description | ~
AQD0020088 Standby
Modify Group Name AO00020087 Standby
AQ00020033 Standby
AQD00200589 Standby
AIDD020040 Standby
AIDDO020041 Standby
AID0020042 Standby
AIDD020043 Standby
AID0020044 Standby
AID0020045 Standby
AQO0020040 Standby
AID0020045 Standby
AQD0020041 Standby
s AI0D020047 standby
AQO0020042 Standby
AIDD020043 Standby
AQD0020043 Standby
AIDD020049 Standby
AQO0020044 Standby
AQD00200590 Standby
AQD0020045 Standby
AQD0020091 Standby
AQD0020045 Standby
AQ0O0020092 Standby
AQ00020047 Standby
AQD0020093 Standby
AQD0020045 Standby
AQO0020094 Standby
AQD0020045 Standby
AQD0020095 Standby
AID0020000 Standby
ATANN?NNMN Standhy e
Import | Export | OK | Cancel

Figure 2-86custom alarm group

4. Domain variable configuration

Domain variable configuration software is an important part of High-performanceHMI configuration
software package. It provides support for the third-party devices and OPC data access via I/O
drivers. In addition, it also provides configuration functions of common variables (Memory driver),
ModbusTCP driver, ModbusRTU and extend configuration variables and system data in OMC
system and inter-domain data access.

Double click "Domain Variable" in the "Domain Configuration” to configure domain variables. The
variable set here belongs to the operation node, and will not be downloaded to controller, but only
can operate in operation node.
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13 vFvarCfg = O x
File Edit Tools View Help

= (%= 8 &8 & #h 7= 7

D | Tag Mame | Type | Description I/Q Driver /0 Address
< >

Common Variables J,{Extend Configuration Variables }‘ Alm Count Variables f
Ready MUM

Figure 2-87 domain variable configuration

If there is third-party data or simulating variable needs to be linked from engineer station, it's
necessary to add normal variable in the domain variable configuration. Driver should be added

before adding variables. Click the driver configuration button i , and pops up the I/O driver
configuration interface to choose required driver type.

[/O Driver Settings >
@ SUPCON Device D... MEMORY Memary Driver

ore OPC Server Driver  SUPCOM, AdvOPCServer...,
Delete IO Driver

View Edit

Exit |

Figure 2-88 driver configuration

Regular driver types are SUPCON device driver, OPC server driver and inter-domain data driver.

SUPCON device driver consists of MEMORY driver. MEMORY driver is mainly used for signal
simulation. OPC driver is mainly used for communication with other OPC server and client terminal.
Inter-domain data driver let user use data in different operation domains under the same project,
realizing the data accessing of cross-operation-domain.

After adding driver is complete, click the adding button B, {0 add tags. Tag type includes analog,
digital and string. For more details, refer to Domain Variable Config Software User Manual.
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@ Attention:
Name of tag added in the local domain cannot be repeat with alias of reference domain tag.

Extend configuration variables setting can solve the complicated engineering data processing
problems easily and ensure the integrality and safety of system supervision by alarm setting
management of tags.

As illustrated in the Figure 2-87, select “Extend Configuration Variables ", then click the adding

button @ on the tool bar to add a variable, shown as Figure 2-89:

Calculation Settings >

Easic l Alamm ]

Tag Name: ||

Description: |

Expression: | J

Low Limit: |E' Tag Group:
Tag G 1] -
High Limit: (100 Tog Growe =l
Tag Lewvel:
it : | -

|Tag| Level 0 j

(0] | Cancel

Figure 2-89 add "Extend Configuration Variables"

5. Panel authority configuration

Double click the item "Panel Authority”" under "Domain Configuration" to set the parameter
adjusting authority of each kind of function block panel.
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1 VFPrivilege _ O w
File View Help
ﬂg /0 Process ) * || Parameter Name Authority Description
B Control Function Bl DetailLevel Operator The Lowest Authori
..... LRDID
----- it PI_PLS
----- 11| PLAE
----- 51| PD_SI
..... tf RATIO
..... L3 sPLIT N | ¥
4 > Turning Panel Authority ;/ Input Parameter , Supervision Pa
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Figure 2-90 panel authority configuration

6. Shelve Alarm

Operator can shelve alarm temporarily to avoid nuisance via alarm shelve. The shelved alarm will
be restored automatically when reaching the shelve time. Maximum 10 shelves reasons and 8
self-define shelves can be configured in VFHMICfg.

Select Domain Configuration/ Alarm Shelve to pop up Alarm Shelve dialog below. In the dialog,
you can configure detail of shelve alarm.

Alarm Shelving *

MNo. MName Shelve Cause | Shelve T... | Default Shelv... | Maximum 5h... | Motify Time | Switch User | Effective... | Lowest User L...

Cancel

Add | Delete Predefined Reason Export Import

Figure 2-91 Alarm Shelve

7. Manage State

State refers to common work scene in field, such as startup, running and shut-down, etc.
VFHMICfg can configure state management via defining key equipment and tag, state and alarm.

Select Domain Configuration/ State Management in VFHMICfg to pop up the State
Management dialog, in which user can define key equipment, device state and related alarm
operation.
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State Management *

Device List: + > State Definition lAIarm Operation ]

. [Z3 DEVICEL [} |State Name |State Description |r.1c|de |Fi|ter Count | Expression
(0 pevice2 01 | Defautt Defaut State Manual |2

-3 DEvIcE:
-

Add

FJik

Import | Export | oK | Cancel

Figure 2-92 State Management

8. Alarm Help

The High-performanceHMI system software supports configuring the operation help of the alarm in
the monitoring configuration, and pops up the alarm help as needed when the alarm is generated
in the real-time monitoring, and then guides the processing of the alarm.

The alarm help in the High-performanceHMI system software supports the following two forms:
® Help template

The help template is used to define the display content and form of the alarm help. The
High-performanceHMI system software supports two kinds of help templates, namely an
HTML template (.html file) and a JSON template (.json file). After configuring the alarm
help in the monitoring configuration software, after the alarm contained in the alarm help
is generated in the real-time monitoring, the alarm-related help file will pop up.

® Procedure documents

Procedure documents (.doc) defines the cause, operational suggestion and possible
results of tag alarms. After configuring procedures in the monitoring software and alarms
included in the procedure occur in the real-time monitoring, the tag alarm-related
procedure documents will pop up.
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By the following steps, users can configure alarm help for High-performanceHMI projects.

1) Select “Domain Configuration> Alarm Help” in the navigation tree, and select “Edit” in the
right-click menu. The dialog box shown in the figure below is displayed

Alarm Help =

Choose Alarm Help Confiiguration Type

(" Alarm Help Template ~ © Alarm Procedure

Cancel

Figure 2-93

2) Select the type of alarm help according to actual needs.
® Select “Alarm Help Templates” to create an alarm help based on the alarm template.

® Select “Alarm Procedure”, then create a procedure file based on the alarm
procedure template and import it into the project.

3) Click “OK” to save the current configuration.
2.7.3 Operation Team Configuration

In control system, different operators supervise different objects, and requirements of different
operators can be realized by operation team grouping. After operation teams are assigned in the
configuration, select items relevant to this operation team and some items can be repeatedly
assigned to different operation teams. It's recommended to set an operation team (e.g., engineer
team), which includes configuration items in all operation teams. When an operation station failed,
this operation team can run in an engineer station, and the running items of the failed operation
team can be checked to avoid losses.

1. Create operation team

Right click "Operation Team" and choose "Add Operation Team", or choose the menu commander

Operate/Add Operation Team, or click the button -_Q on the tool bar, a new operation team
would be added under the item "Operation Team". Operation team name and switch Priority can
be modified. For example, modify the name: engineer team, switch authority: privilege, shown as
Figure 2-94.
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Figure 2-94 add an operation team

Switch Priority is the authority for operator to switch operation team during supervision. Switch
priority is privilege in the above figure, it means only operator of privilege level can switch from
other operation team to “Engineer team” during supervision.

2. Add overview window

Overview window can be used to supervise the tag value or to switch between pages.

Right-click operation team and choose "Add Overview Window", to add the overview node
EIE O Erie

[ [1]overviewl {5 the operation team. Users can right-click the node “Overview” to add new
overview window. and double-click it to edit.

Then "Overview" and the first overview page will automatically be generated under this operation
team. New pages can be added from right-click menu of "Overview", and can be edited by double
click the new page.

Other overviews of this operation domain can be edited in this way under the operation team.

3. Data viewer window

Data viewer window can be used to supervise tag value; relevant tags can be placed within one
page according to control requirement to make observation more conveniently.

Adding data viewer window is similar to adding overview. All data viewer window of the operation
domain can be set under the privilege operation team.

4. Tuning group window
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Tuning group window is used to display instrument panel by group. Relevant panel can be placed
within one tuning group window according to control requirement.

Adding tuning group window is similar to adding overview. Complete All tuning group windows of
the operation domain can be set under the privilege operation team.

5. Trend window

Trend window is used to display tag trend. According to the relevant requirement, relevant tags
can be placed within in one trend window for comparing and check.

Adding trend window is similar to adding overview. All trend windows of the operation domain can
be set under the privilege operation team.

6. Graphics configuration

Graphics is one of the most important supervision and operation displays in the control system,
and usually used to display technical process and operation condition of the controlled devices
and objects, and can be used to operate relevant data.

Graphics support VBScript script programming language, and bitmap, ICO, GIF, FLASH, etc. can
be introduced freely.

Add graphics in the same way of adding overview window, input file name, then click the button
"edit" to enter the interface of graphics editing software.

Bl vrHMICE - O ¥

Eile Edit View Operaticn Help

T BRI BRER XA H:@J& BB M EEE ~

= d:":.: Operation DomainD [tern Mame | [tern Value |
=8 @ Operation Team Page 1
=14 Team0001 Page Description | IND BHARAT

o %HE&T?}TEHM File Name IND BHARAT. 2|

- [IE Graphics Edit Edit |
------ |D [1]IMD BHARAT Alias of Reference
o |D [2]1Graphics2

----- ¥ Alarm Region

.25 Alarm Panel

..... ¢fl Alarm Sound

&5 Alarm Real-time Print

----- E> Operation Instruction

----- TR Tag Associated Graphics

----- % Tag Associated Trend "

Ready DNECSI

Figure 2-95 adding a graphics display

If there is completed graphics, click the "?" (as shown in the above figure) to select corresponding
graphics, shown as follows:
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B OpenFile *
Current Operation Domz v | | D:\ECSData\INDBARATHPOWER \Hmi\OAD \pic E2-
Mame | Size | Modified Time |

Fieame: |
File Type: | * pic Cancel

Figure 2-96 select a graphics

Complete configuring all graphics of the operation domain. Graphics belongs to resource file, and
can be edited by several engineer stations at the same time. (Different graphics can be edited by
several stations at the same time, but one graphics can only be edited by one engineer station at
one time). All the graphics are summarized in the "Graphics" under "Resource Files".

7. Report configuration

Report is an important and frequently used tool for data recording. It's usually used to record
important system data and on-site data for technicians to carry out system status inspection and
process analysis. Report builder software consists two parts of report building and report data
configuration according to function. Report building to establish the form of the table for data
recording; report data configuration is mainly to set the event definition and report output
according to requirement. After the report is configured, report would be generated by report
server during supervision.

Select the Icon E on the toolbar, and pops up report mode selecting dialog box (normal report
or Excel report). Choose one mode (normal report is chosen here), report node would be added
after confirmation, and “Report 1” would be created by default. Then click button “Edit” to open
report editing interface, for more detailed report configuration method, refer to Report Software
User Manual.
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Figure 2-97 report configuration interface (normal report for example)
8. Scheduling configuration

Scheduling enables system to define and set special operation task according to certain rules, and
run assigned task timely and efficiently.

Add scheduling pages in the same way as adding overview display, and input file name, then click
button "Edit" to open scheduling editing software interface. The method of adding scheduling
configuration is similar to adding graphics.

Scheduling mainly includes time scheduling and events scheduling. As shown in Figure 2-98, click

the button © to enter time scheduling configuration, or click the button (] to enter events
scheduling. For more detailed configuration method, refer to chapter "scheduling configuration” in
HMI Config Software User Manual.
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Figure 2-98 scheduling configuration interface

9. Custom keys

Custom keyboard commands configuration is to define the function of 32 (or 36, operator
keyboard include 2 types, 32 and 36, maximum 36 can be defined in software) blank keys in
operator keyboard, including key setting, page switching setting and value assignment setting. It's
recommended to configure custom key of all the operation teams uniformly for convenient
operation.

Adding custom key is similar to adding overview window. The following figure shows how to set the
function of custom key 1 on the operator keyboard as jumping to trend window.
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Figure 2-99 custom key setting

10. Alarm and region setting

Only the alarms of tags in alarm region selected in the alarm region setting can be shown in the
supervision window; as for the unselected region, the alarm can't be displayed even if the tag is
configured with alarm. Alarm grouping in the alarm region is determined by the settings in "Custom
Alarm Group" of the domain configuration.

Double click the "Alarm Region" under the operation team for setting.

11. Add inter-domain alarm

User can manage the tag of reference domain if the current operation domain has referenced
domain.
Right-click an operation domain in configuration tree and select “Add Referenced Domain Alarm”,

to add the trans-domain alarm node with the icon , double-click it to set the details of referenced
domain alarm.

12. Alarm panel settings

Alarm panel is an important function on the alarm tool bar. It provides the function of displaying
alarm in 3 modes by alarm region, graphics and tag, which is convenient for user to obtain current
alarm status in concerning area (special alarm region, appointed graphics or relevant important
tags) and address it timely.

Double click "Alarm Panel" under the operation team (after adding "alarm panel") for setting.
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13. Alarm sound configuration

Alarm sound configuration is to set alarm sound for a specific alarm to draw the attention of
relevant operator. If the alarms in the operation team require sound prompt, it can be set here.

Double click "Alarm Sound" under the operation team for setting.

14. Alarm real-time print settings

It requires alarm real-time print setting if real-time alarms need to print out and there is printer
connected to the system.

Double click "Alarm Real-time Print" under the operation team (after adding "Alarm Real-time
Print") for setting.

15. Alarm popup settings

Important tag supports popup display to inform user.

Right-click the operation team and select “Add Alarm Popup”, to add the node &l Pop-up Alarm ,
double-click it to set the details of alarm popup.

16. Tag associated graphics settings
In supervision window, if it's required to jump to the relevant graphics by clicking the graphics

jumping button @l on the tag panel in the supervision, it should be configured in tag associated
graphics settings.

For example, the following figure shows how to jump to graphics "Cooling Water System" by
clicking the button on the panel of tag AO00020016.
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Figure 2-100 tag associated graphics settings

17. Tag associated trend window settings
In supervision window, if it's required to jump to the relevant trend window by clicking the trend

jumping button EI on the tag panel in the supervision, it should be configured in tag associated
trend settings. The setting steps are same as that of tag associated graphics.

18. Configure other operation team

Create a new operation team first, then select the page needs to be supervised in the overview
within "engineer team”, and choose "Copy" in right-click menu, shown as Figure 2-101.
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Figure 2-101 copy overview window

Then right click the new operation team and select copy or click the Icon el on the tool bar,

shown as Figure 2-102:

Bl vrHMICEG

= O

| Eile Edit View Operation Help

|EH s R (D6 X HENE ERRNEAE IISEE (R

>

Eoed Operation Domainﬂmdd Operation Team!
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'ﬂ Tearm001
ﬂ Team0002
[_]gg Demain Configuration

----- |# Domain Variable

----- I¥ User Authority

..... History Trend

..... §8 Custom Alarm Group
fﬂ Panel Authority

----- i= Alarm Shelving

..... [E State Management
..... B Alarm Help

(-] Resource Files

Switch Priority

Add Operation Team

[DAECSData\INDBARATHPOW

Figure 2-102 copy overview window

Thus the overview is copied to the new operation team. Other settings including data viewer,
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tuning group, trend graphics configuration, report configuration, scheduling configuration, custom
keyboard commands, can be added to the operation team following the same steps.

It's recommended to set graphics of each operation team identically, so it can be copied from the
operation team "Engineer team". Alarm and real-time print settings can be set individually by
operation team, or be set in accordance with "Engineer team".

2.7.4 Resource Files

All files in folders under the directory of local configuration, including PIC folder (graphics files),
BGTemplate folder (background model of the graphics), SCH folder (scheduling), TGD (tag group)
folder, Template (graphic object model) folder will be list in the corresponding resource files. Figure
2-103 lists resource files of graphics.

B9 vrHMICE - O X

Eile Edit Yiew Operation Help

FH bR DR X EEHE R B eI SEERET”
_a Team0001 # | Filename | Lock Operatic... | Last Modified Time |
(-7 Team0002

[—jgj Domain Cenfiguration

----- |2 Domain Variable

..... I User Authority

..... History Trend

..... (& Custom Alarm Group

ﬂ;ﬁ Panel Authority

..... i= Alarm Shelving

..... [’ Stete Management

..... B Alarm Help

- Resource Files

----- 8} Graphics|

..... ([ Pop-up Graphics

----- (L] Background Template of Graph
..... [_] Points Manager W
c > £ ’

Ready D:AECSDatat|INDBARATHPOWERNHI

Figure 2-103 resource file list (Graphics)

Normally, these resource files cannot be edited or uploaded. If need to be edited, they should be
locked first by clicking the corresponding “Edit” button, then pops up a prompt whether to lock the

resource file. Click "Yes" to edit the resource file and the sign o "Red tick" will appear in front of
the file name. The name of the operator station (Engineer station) that is locking the file will be
displayed in the column "locking operation station". If some resource files are locked by other

operator station (Engineer station), "Blue tick" will be displayed in front of the name of the
resource file and the name of the operator station (Engineer station) that is locking the file will be
displayed.

When there is a resource file in local machine but not in the server, an arrow sign * will be
displayed in front of the name of the resource file, indicating that this file isn’t in the server and
needs to be uploaded.
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1. Create new resource file

Graphics (excluding back ground models of graphics and graphic objects) , tag group and
scheduling files can be created by directly inputting its name in the resource list. Choose

"Graphics" under "Resource File" and click the button& , pops up the following dialog box, then
input the file name.

Mew Resource File pod
Filename | | Mew |

Figure 2-104 create a new resource file

Click "New", graphics editing interface pops up and can be edited (it will be locked and uploaded
automatically).

@ Tip:

Newly created local resource file will be uploaded to server automatically (being locked while
uploading).

2. Delete resource file

The unlocked resource file can be deleted, and both local file and the corresponding file on the
server will be deleted at the same time. When the deleting operation is performed, if the operation
domain is also locked by current user, user will be asked whether to synchronously delete quoted
relations of the deleted resource file in the operation team.

3. Update resource file

Right click in the resource file list, pops up the right-click menu as follows ( if the resource file is not

locked, there will be only 3 items available, "upload resource file to local”", "Find Resource File"
and Export Res File, others will be gray and unavailable).

Save to Configuration Server
Sawve to Configuration Server and Keep Locked
Unlock Resource Files Directhy

Update Resource Files to Local

Find Fesource Files
Cnline Publish...
Export Res File

Figure 2-105 resource file right-click menu
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Choose "Update Resource File to Local", and it will prompt whether to update resource. Choose
"Yes" to complete updating resource file, the local resource files are then replaced by the file with
the same name in the server. (When updating the resource file, if the corresponding resource file
is open by the editing software, it will prompt that the software is open. Relevant software should
be closed before updating resource file)

4. Find resource file

Choose "Find Resource File" and pops up the dialog box shown as Figure 2-106:

Find Resource File ot

Find Conkent: |

Mexk | Details ==

Figure 2-106 Find resource file

Input the resource file name needed to be found, and click “Find”. Fuzzy search is supported. For
example, there are two graphics of "Vacuum furnace" and "Vacuum tower" in the graphics
resource files. Input "vacuum" in the input box and click “Find”, resource files with name containing
the word "vacuum" would be found. Click the button "Next" to find another one. Click the button
"Details", all the resource files with name containing the word "vacuum" would be displayed and
whether the resource file is locked and the last modified date would also be displayed, shown as
Figure 2-107:

Find Resource File ot

Find Conkent: | WaCUM

Mexk | Details <« |

Filzname | Lock Operation ... | Last Modified Time

Wacuum furnace., pic DESKTOP-QKFD,..  2021-08-1011:05;5¢8
Vacuum bawer, pic DESKTOP-QKF9,.. 2021-03-1011:06:5¢
£ >
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Figure 2-107 file finding and detailed information

5. Save to configuration server& Save to configuration server and keep locked
There are 2 ways to save resource file:

® For local resource file which needs to send to configuration server, right-click it and
select “Save to Configuration Server”.

® For resource file locked by current user and needs to keep locked, right-click it and select
“Save to Configuration Server and Keep Locked”.

6. Unlock resource file directly

Choose right-click command "unlock resource files directly” and pops up prompt “the operation will
lead to lost saved contents, sure to continue?" The resource file will be unlocked after confirmation.
After this operation, the file being edited will be in read-only status and no longer able to be edited.

7. On-line publish

Only the resource file locked by current user can be published on line. Choose "Online Publish" (if
the resource file hasn't been uploaded, it will upload automatically first), and pops up the dialog
box shown as in Figure 2-108.

Configuration Publish - Operation

Mode List
| Mame Skatus | | Supervision Offline Publish
[11.139]3erver_0_129 Configuration is Consistent . Mok Skarted COFffline Publis
Q [0.129]0peration Mode_0... | OFfline . Lnkniomwn
£ >
Skatus Info.

2021/03/10 11:09:09=5kart to dekect changes of configuration =;
Add File"\PICLA MEWY RESCURCE FILE. pic"
Add File"\PIC\Wacoum Furnace. pic”
Add File"tPICY W acuum tower , pic"

#Has Changes Above x>,

Cnline Publish |
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Figure 2-108 configuration publish dialog box

Then the modified part will be listed in the column "Status Information”. Click button “Online
Publish" to publish online directly.

j Tips:

® Publish will not update modified tag quoted in the graphics, newly added graphics and
other external configuration.

® For more details about configuration publish, refer to Config Explorer user manual.

8. Export Res File

Select a resource file in the list, right click and select “Export Res File”, pop up Browse For Folder
dialog box. Select directory and click “OK” to export the file.

9. Import Res File

Select a resource file folder, right click and select “Import File”, to pop up “Import Resource Files”
dialog. Multiple-selection is supported by the key Ctrl and Shift to import several files at one time.

2.7.5 Save Configuration to Server

When supervision is start-up, configuration information of supervision is read from configuration
server. Therefore, after configuration is complete, it should be uploaded to server. Select domain
name and right click it, pops up right-click menu, shown as follows. Choose “Save to Configuration
Server” or “Save to Configuration Server and Keep Locked” to save configuration to server.

= VFExplorer - INDBARATHPOWER — O X

File Edit Debug WYiew Help

B ~| B N | @
- t [0.60]5team_Water A | Mame |Descriptiu:un |SCnetAAddress
- fi& [1]Control DomainT EElserver_1_156 172.20.1.156
E|-- HII

% Open From Configuration Server

Operation Don

Opesation Don Save to Configuration Server

Save to Configuration Server (Locked)

Edit...
Publish Configuration...

Output ESFIN - *

% Output /Find %, Find Detail /
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Figure 2-109 Save configuration to server

2.7.6 Publish Configuration

After configuration or modification is complete, configuration information should be published to
server and each configuration node (inform nodes that there is new configuration needs to update),
to make it convenient for each operation node to get latest configuration files and information.
Engineer can choose one operation domain to publish configuration by sending configuration
synchronization information to each server and operation node within the operation domain, and
each operation node can obtain updated configuration from configuration server.

Operation procedure of Configuration Publish is shown as follows:

Choose an operation domain under “Supervision Configuration” and right click it, pops up the
right-click menu, then choose “Configuration publish”, the following configuration publish dialog
box would pop up.

Configuration Publish - Operation Domain0

Mode List
| Mame Status | | Supervision Offline Publish
F5 [1.156]Server_1_156 Publish sucreeded! & ot Started Offline Publis
< >
Status Info.

Madify Custom Function Black -
Modify Custom Program
Modify Custom Program
Modify Hardware Configuration
Modify History Trend Trend Database Configuration
Maodify History Trend History Data Server settings
Modify HMICfg Alarm Group Settings
Add Operation Team Team0001
Add Operation Team Team0002
Modify Monitoring User Authority
«Has Changes Above >,
20210715 11: 27: 27:Initializing configuration publish, please wait. ..
20210715 11: 27: 27:Configuration publish initizlizing has finished!
2021/07/15 11:27: 27:Configuration publish starts...
20210715 11:27:28:Config

Figure 2-110 configuration publish

The project configuration can be published in the mode prompted by the software according to
whether the button “Online Publish” and “Offline Publish All button” are enabled or not.
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@ Tip:

If online publish is allowed, it will be carried out first, then nodes that are not able to be
published online will “Publish Offline All”. “Publish Offline All” won’t be effect until the
supervision is reset.

2.7.7 Start up Supervision

Before start up supervision, make sure the configuration has been saved and published to
configuration server; otherwise the running configuration won't be the latest one.

Double click the supervision software icon, 2 and if there isn't any configuration under the
local running directory, a prompt dialog box whether to synchronize the configuration will pop up; if
configuration exists under the local running directory but not in accordance with the configuration
in the server, a dialog box whether to update configuration will pop up. After the configuration is
updated, choose the operation domain and start mode, shown as Figure 2-111:

Configuration Selection

=Configuration Publish Path=

D:\SUPCOM_PROJECT \~Publish\INDBARATHPOWER Update |+
Operation Domain Start Mode

v

-

[v Supervision Software

IIpdate Information

Local configuration is consistent with the server configuration

Cancel

[ Do not show this dialog next time.

Figure 2-111 choose operation domain / start mode

After confirmation, login the supervision with authority of observer, then the operation team is
empty, and user should be switched and operation team should be chosen in the supervision.
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Legin

£

—Login

User Name:  (FRTTH

Fassword: I

Operation Team: Auto Login...

!

Team0001
Team0002

Login Cancel

Figure 2-112 switch user and operation team
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Section 3 Adjust Configuration

3.1 Steps to Adjust Configuration

3.1.1 Adjust Control Station Configuration
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Figure 3-1 steps to modify control station configuration

3.1.2 Adjust Operation Domain Configuration

Operation domain modification not only includes operation domain modification, but also the
configuration modification of control station relevant to operation domain configuration.
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Figure 3-2 steps to modify supervision configuration

3.2 Project and Configuration Backup and Restore

Table 3-1 configuration backup and restore

Backup/Resto | Backup and Backup Restore

re ltems Restore Software | Operation Operation Attentions
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Backup/Resto
re ltems

Backup and
Restore Software

Backup
Operation

Restore
Operation

Attentions

Whole Project

System Builder

File-> Project

File>Restore

Make sure there is no file
locked in the project,
otherwise backup

Software Backup configuration is not the
latest
(Select the Refer to the chapter “Import
Single Control System Builder Control (Selec_t the _Control and export of control domain”
: - . Domain)Edit-> . .
Domain Software Domain)Edit-> | ; in System Builder User
; mport Domain
Export Domain Manual
. (Select the (Select the Refer to the chapter “Import
Single . ) . .
Operation System Builder Opera_tlon _ Opera_tlon _ and export of operation
Domain Software Domain)Edit-> Domain)Edit-> domain” in System Builder

Export Domain

Export Domain

User Manual

(Select the
Single Control Config Explorer Control (Dsoerlwez:i;t)rléeditcigmro'
Station 9 EXp Station)Edit-> E .
xport Domain
Save as
Hardware Hardware
. . Configuration File-> Save as File->Import
Configuration
Software
Tag Tag Builder o -
Configuration Software File-> Export File-> Import
FBD Program FBD programming File-> Export File-> Import
software
LD Program LD programming File-> Export File-> Import
software
ST Custom ST Custom function . .
function block | block Software File-> Export File->Import
Select graphics in the
software VFHMICfg, and
Graphics Manual File Copy select “Open” on the menu
bar to open local directory of
graphics.
Domain Domain Variable
. Configuration File-> Export File-> Import
Variable
Software

3.3 Adjust Hardware Configuration

Table 3-2 adjust hardware configuration

Main adjustment

Set parameters of controller, add/delete module, set module and

items channel, configure communication module.

%ﬁg\:ﬁﬂon Save - Control station on-line download-> Publish configuration of
. 9 corresponding operation domain.

adjustment

Related effects of

configuration

others won't.

If the type of module is modified, relevant tags will be affected and
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3.4 Adjust Tag Build

Table 3-3 Adjust tag build

Main adjustment
items

Add/delete tags, adjust parameters including tag name,
description, address, measuring range, alarm limits, etc.

Operation
following
adjustment

Save - control station on-line download->publish configuration of
operation domain

Related effects of
configuration

Modification type: custom program needs to be modified.
Modification name: the tags used in the supervision configuration need
to be modified.

3.5 Adjust Control Configuration

Table 3-4 adjust control configuration

Main adjustment
items

Add / delete custom program, adjust custom program and custom
function block, adjust program period or phase, modify function
block tag.

Operation
following
adjustment

Save - control station on-line download

Related effects of

Modify tag name of function block: the tags used in the supervision

configuration need to be modified.
Modifying parameters of function block with tag should be carried out
remark according to the sequence of adjusting measure point configuration,

and configuration of relevant operation domain should be published.

3.6 Adjust Supervision Configuration

Table 3-5 Adjust supervision configuration

Main adjustment
items

Modify graphics, operation team, panel authority, etc.

%ﬁg\ﬁﬁ:on Save - Save to configuration server - Publish operation domain
: 9 configuration
adjustment
Related effects of
X ) None
configuration

3.7 Configuration Test

After the abovementioned adjustment, configuration should be tested for correctness. For more

details about test method, refer to relevant content in Section 4.
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3.8 Adjust Configuration Parameters

Tags parameters, function block parameters, program parameters can be modified and then
downloaded on line. For more information, refer to relevant contents in Configuration Adjustment.

3.9 Parameters On-line Adjustment

Tag parameters, function block parameters can be modified in the panels of tag debug, program
debug and supervision function block (some parameters can only be adjusted in configuration).

3.10 Parameter Backup
3.10.1 Parameter Upload

User can upload all parameters in current configuration in VFEXxplorer.

Select the menu commands Edit/ Upload Parameter, and a prompt of “Uploading parameters,
please wait” will be shown in the interface until it is completed. Then a prompt of “Whether save
parameter value to configuration” will pop up. Select Yes to save parameter value to configuration
and click No to stop uploading.

Process as below when prompts pop up during uploading:
® If current configuration and controller configuration are different, a prompt of

“Configuration inconsistent” will pop up, and uploading will be forbidden.

® If controller is not existed, a prompt of “Cannot connect controller” when uploading
parameter will pop up, and uploading will be forbidden.

® If controller versions FCU711 and FCU712 are mismatched, a prompt of “Controller
types mismatch” will pop up, and uploading will be forbidden.

Tip:

@ If computer A opens the FCU711 simulation controller, computer B opens the same FCU711
configuration, when uploading parameter in computer B, a prompt of “Controller types
mismatch” will pop up and, and uploading will be forbidden.

3.10.2 Tag Parameter Backup

Select the tags that need backup in VFTAGBuilder.
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E VFTAGBuilder - INDBARATHPOWERN Combustion\ Control Station_172_200_... — O >

| File Edit Operation View Help
J x | Analog Input

Mame Description Minimurm Maximum L

-E
RN [N N T W T
Standby 0.0000 100.0000 E
_ SR <& Add Tags 0.0000 | 9

Anal... AIDDD20004 Srandhy | #5 Delete Selected Tags 0.0000  ©
= B Modify InBatch ~ Ctrl+B =

(E Detect Tag Usage

ag ANDM20001 properties checking warning: ‘
4 L2 <l - Set As Type Ternplate

01. Tag Al corresponding channel address

Tag AIDDD20000 properties checking warning: il T Lo T Lt

01. Tag Al corresponding channel address Check Tag Properties
All the tags pass the properties check,
Failed to check all tag!

A [ Output / Il N

W

Figure 3-3 Upload tag parameters

Then upload parameters and back up. For more details, refer to the relevant part of Tag Builder
User Manual.

3.10.3 Save Functional Parameters of Program

As illustrated in Figure 3-4, the real-time value of running program can be saved to configuration,
e.g., PID parameters, alarm limits, etc.
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TR e R L L a parameter Save
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00000,
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[« |

* I | Hame | Rnnotationl Curre:
1 Alooozoozl Standbr a.
2 Alooozoozz Standbr 0.

rFunction Block

—Parameters
Mame Type | Initial value | Real-time V... | Descripkion |
@ K1 REAL 1.0000 1.0000 Input 1 Offset Coefficient
@ Kz REAL 1.0000 1.0000 Input 2 Offset Coefficient
2=t REAL 0.0000 0.0000 Input 1 OFfset
Bz REAL 0.0000 0.0000 Input 2 OFfset

LRy TagTeam A A W‘ﬂﬂiﬂ [ Prompt to Save the Real-time Yalue

Cancel

Ready

Figure 3-4 Upload program parameters

3.11 Solutions for FAQ

Problem 1: It's unable to call out the operation panel of function block.

Solution prompt: check the following items:

A: Whether the function block is equipped with a panel by system?

B: Have you defined a unique function block name for the module?
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Section 4 Debug Guide

4.1 Basic Concept for Debug

After project program and graphics configuration are complete, it should be debugged. Debugging
includes 2 parts of system debug and technical interlock debug. This manual mainly introduces
system debug, static tag debug, program debug. Technical interlock debug will not be introduced
here.

Table 4-1 debug method

Debug types Debug purpose

Hardware channel debug | Examine whether hardware module is normal, used for factory test.

By tag debug, tags can be assigned different values and alarm limits. It is mainly used

Tag parameter debug to support program debug, and can also be used for hardware channel debug.

Program debug Examine whether program logic is correct.

Field tag test Observe whether field data points are in accordance with the graphics and whether
the measurement and output is accurate, normally carried out in the field.

Debug controller load after program debug to make control station run more

Controller load debug smoothly.

4.2 Debug Hardware Channel

Hardware channel debug can be carried out after hardware configuration. Power the control

station and open hardware configuration interface; click the button % on the toolbar to enter
on-line debug status. Then input signal to the 10 channel (input channel) one by one, the value of
relevant channel can be viewed in the interface to check whether the channel is normal and
whether accuracy of measurement satisfies requirement. Or input value to the channel (output
channel) directly and observe whether channel output is normal.

It's recommended that the configuration only contains hardware configuration when debugging the
module channel (factory debug). If the AO/DO tags have been configured, it's unable to set the
value of AO/DO in the hardware configuration interface, and AO/DO module should be checked by
tag debug. It's recommended to create a new hardware test configuration when debugging the
hardware channel, and then using the auto-scan function of hardware configuration software to
scan the hardware information to configuration automatically, and test the channels afterwards.
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Workspace
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Figure 4-1 hardware debug

@ Tip:

Measuring range of analog data can be set freely when debugging hardware configuration.

4.3 Control Station Configuration Debug

4.3.1 Tag Parameter Debug

By adjusting specific parameters of the tag, tag status including alarm limits, force or not, etc can
be changed. Tag debugging can be carried out in the tag build interface, program configuration
interface and function block panel.

Debug in tag build interface: click the button %: on the tool bar, tag build interface can enter
debugging status. Then all parameter values of each tag in the interface can be viewed, and the
relevant tag parameters can be set in the right window for debugging. For the meaning of each tag

parameters, please refer to relevant instruction manuals.
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E VFTAGBuilder - INDBARATHP OWERN Combustion’ Steam_Water[0.60] e O >
| Eile Edit Operation View Help

| @ 2 | analog Input | (R EEE D

D | Type | [ame | Description | Minirmurm | Maximum | Lo
AI00020000 Standby 0.0000 100.0000 |9

1 Standb 0.0000 100.0000 ¢

2 Ana 0.0000 100.0000

3 Ana AI00020003 0.0000

4 Ana AI00020004 0.0000

Ana AI00020005 0.0000 100.0000

£ Ana AI00020006 0.0000 100.0000

7 Ana AI00020007 0.0000 100.0000 v
< >

=

1

& | 14] 4 [v]}\ Output / 4] ]
Ready | Motd 2

Figure 4-2 tag debug

Tip:

Gy

When communication between controller and AO/DO module interrupt or channel between
controller and AO/DO module cut down at the state of not debugging controller, tag “AO/DO”

would turn into fail_safe state. The value of tag will be the fail_safe value or lasting output

value.

Debug in the program configuration interface: click button %= on the tool bar in the figure below,

- . ? [
program interface can enter on-line debug status. Buttons Clg2 correspond to program
debug, function block debug, activate all input parameters and output parameters. Besides, user

can select the menu commands Program/ Variable Debug to debugging variable.
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1k VFFEDBuilder - testproject\CombustionySterm_Water[0.2] - [Cyclel - Simulation] - [state: running time: 5 us] o O X
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Figure 4-3 Program debug interface

Double click a tag in the interface shown in the above figure, relevant information will be displayed
in the variable debug interface as follows. Double click current value, the following window will pop
up to input forcible value, and then double click force or not to pop forcible window. Shown as
follows:

ACQ0020000[5tandby] hd ACQ0020000[5tandby] >
Oukput Real-time Yalue = -
Current Yalue: $
0.00 o M
Forced Yalue:

Figure 4-4 set tag value

I:q_a'_' Tip:

It's recommended to debug tag parameters in the tag panel. Corresponding tag panel can
pop up in the supervision.

4.3.2 Program Debug
Modify parameters

Value of tag or parameter can be modified in the tag debug or function block debug interface.
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Input forcible value

In order to test whether program function is correct when debugging program, input tag can be set
to forcible, then manually input tag value to examine whether the program satisfies anticipation
with different tag values.

Activate / close function block

Program paragraph unit debug. The value of function block with connection is assigned by its
upper function block. It allows closing the input or output of the function block during unit debug.
The input parameters of function block whose input is closed are not assigned by upper function
block, and can be modified freely. The calculated value of the function block can't be transferred to
downstream function block if its output is closed.

Forcible output

The value of forcible output tag is only assigned by manual output, and isn’t connected to program,
which allows adjusting program without worrying about abnormal output.

4.4 Items of United Debug, Tools and Method
4.4.1 Field Data Point Test

Input point: input signal from field and observe whether the corresponding data in the graphics is
correct.

Output point: signal is assigned from graphics (Set the parameter in the “Debug Mode* of the
controller to “Enable “. Pop up output tag panel, and set the tag to forcible, then input forcible value
directly), and observe whether the corresponding signal in the field is accurate.

4.4.2 Controller Load Debug

View phase load is shown as Figure 4-5:

97



Project Guide User Manual

E VFExplorer - INDBARATHPOWER — O >
File Edit | Debug View Help SR e e
Online... Chrl+L | | Phase | Run Time (ms) | Load (%) | _
E--@ INDB2 Start Custom Program & | Name | 0 0,522 0.52 fied Time | Patl
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-3 Sy - - Wl Hardw, | 4 0,520 0.52 #17:5%57 D
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'ﬁj i e Tag T4 5 0,505 0.51 A2275:19 D\l
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-4 TEST [ErrList| | g ooz B DA
Phase Class Library 9 0.466 0.47
----- [ Program Template Library il L
[—]% Control Configuration
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D rarm . im - a 4
£ > L4 >
J: Unit control program compiles successfully! -

W

l Save to configuration server successfully!

% Output /Find %, Find Detail / | |

Figure 4-5 View phase load

Program phase can be adjusted if the phase load allocation of controller is unbalanced. If the
phase load is too heavy (if phase load exceeds 70%, controller will alarm, and if exceeds 85% the
program will stop), program function period can be adjusted in order to decrease load.

4.5 Resolutions for FAQ
4.5.1 Field Signal Abnormal

Input tag: when data is abnormal, firstly check whether corresponding channel value is correct in
the hardware debug display. If the value is correct it means that the data of I/O module is correct.
Then check whether tag value is correct. If not, it means that there are problems in tag settings
and it's necessary to check tag settings; if correct, check relevant settings of graphics and
supervision configuration. If channel data is incorrect, check channel configuration settings, wire
connection and field signal.

Output tags: when data is abnormal, firstly check whether corresponding channel value is correct
in the hardware debug display. If the channel value is correct, it means that the output value of the
tag is correct, check hardware channel settings, tag practical output and field wire connection. If
the channel value is incorrect, check whether the value and settings of the tag in the tag table is
correct.

4.5.2 Program Abnormal

1. Check whether there is any closed function block in the program.
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Check whether all input and output of the function block in the custom program are

activated when in online status within the VFExplorer, shown as Figure 4-6:

Marne | Run Status | Input Closed Sta...
Running Al Activate

fﬁC}fcled Funning Al Activate
ﬂcycleE Running LI Sctivate

Figure 4-6 input and output status of function block
Not all input of function block shown in the figure above are activated. In on-line status,
double click the function block to open the program, then select the function block and

choose "Activate input" in right-click menu, shown as Figure 4-7:

@ADDDMDDDD.BKDUT | 2008000

[Mloooozo000 BrouTe.. .~ |2
PIDO1
* PO 00RO anooozoooon
*  MODULE B EKIN o .
:0.00| IFIN DH |o.00 BEKINERR iz Prapartizs..
0.00|IgH Hr 2038 EPY  BK Parameter Settings...
0.02/ = s 0.00 poooz thow Associated Program...
a.20|J1 -
pOO0Z = Assign FF Tag...
Deassign
Cut o1
_______________________________________________________ Copy :
Paste
Delete
I Activate |nput I
v Activate Output
Check Lagic
Debug Logic

Figure 4-7 resolution for program abnormal condition

Check whether input and output is forced.

View the force status table in the supervision.

[T Status Table - a X
FORCE | cos | saFesTA | REcowER | AoF | FUCK | oveRRance|  top HF copP SIMUL SUPPRESS | Fisfor ]
Tag Description Alarm Type | Value Tirme
000 / FORCE 0.000

[Alarm Amount: 1

Figure 4-8 input and output force status table
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Section 5 Configuration Download and Publish

5.1 Download Attentions

It's forbidden to download offline when plant is running, and if it prompts unable to download on
line, plant should be shut-down for downloading offline.

Compiling will be carried out automatically before download, and it would be unable to download if
there is any compiling error. Configuration error should be located and corrected by download
prompt, and then download again.

Downloading process should not be aborted.

5.2 Configuration publish Attentions
® Make sure modified configuration has been saved to server before configuration
publishes.
® Resource files should be Publish individually as possible.
® Configuration releasing process should not be aborted

® Make sure that process information network works normally before publish, because
configuration publish is executed via process information network.
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Section 6 Maintenance Guide

Control system is composed of system software, hardware, field instrument, etc. If any part fails, it
will result in system function partly disabled or systematic failure, even result in plant shut-down.
So it's necessary to treat all equipments as a whole and provide complete maintenance.

@ Attention:
Replacing component in maintenance must be appointed by supplier.

6.1 Control Station Maintenance

Check the working condition of module frequently to see if there’s failure occurred (whether Fail
light is on).

Check the working condition of DC supply frequently.
Check fastness of the grounding wire frequently.
Use anti-static brusher and blower to clean control station regularly.

Change standby module timely after fault is verified.

6.2 Operator Station Maintenance

Clean display using wet sponge regularly, but don't use alcohol and ammonia for cleaning.
Clean the meshwork of the host computer regularly.
It's forbidden to connect, remove, or move the host computer of operator station when power on.

It's forbidden to change the configuration and settings of computer system, add, delete or move
files and directory in the hard disk arbitrarily.

Use external floppy disk or Compact Disc cautiously to avoid virus invasion.
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Section 7 Revision

Table 7-1 Revision history

Document Version

Applied to Software Version

Remarks

V1.0(20230301)

OMC High-performanceHMI V4.70.00.00

First release

V1.1 (20230830)

OMC High-performanceHMI V5.10.00.00-M

Updated screenshots.
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